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Cuvânt înainte 

Modelarea  fenomenelor și proceselor inginerești, reprezintă o provocare, devenită posibilă datorită 

dezvoltării tehnicilor și algoritmilor de calcul şi a componentelor hardware din structura 

calculatoarelor. Programele de simulare numerică, bazate pe motoare puternice și interfețe 

prietenoase, sunt astăzi la dispoziția celor care doresc să reproducă fenomenele fizice implicate în 

scopul determinării cu rapiditate a unor soluții optimizate, sau care să verifice conceptual 

arhitectura/ideile sistemelor propuse. Rezultatele acestor simulări numerice pot să fie folosite și 

pentru a valida diferite soluții pe care le poate întrevede inginerul proiectant astfel încât să permită 

optimizarea proiectului final. 

Dintre toate tehnicile de simulare numerică, Metoda Simulării Numerice a Curgerii Fluidelor și 

transferului de căldură (Computational Fluid Dynamics - CFD) are un rol extrem de important în 

proiectarea și verificarea diverselor proiecte care implică curgere si transfer de căldură și face să nu 

fie nevoie, cel puțin în diverse etape ale dezvoltări, de partea experimentală care era de neînlocuit 

până acum câțiva ani. Aceasta oferă o nouă cale eficientă, fiabilă și economică pentru cercetarea în 

domeniul transferului de căldură și a devenit un instrument esențial de cercetare în acest domeniu. 

Înainte de apariția simulării de tip CFD, studiul cazurilor de interes era limitat la investigația 

experimentală și corelația empirică, ceea ce ducea fie la durate mari pentru studiu pentru studiul 

experimental, fie la abateri mari datorită corelațiilor empirice insuficient de precise.  

Ținând cont de dezvoltarea din ultima decadă a tehnicilor de simulare numerică de tip CFD, 

coroborată cu creșterea rapidă a puterii de calcul și scăderea rapidă a prețului hardware-ului, este 

de așteptat ca tehnica CFD să câștige în continuare popularitate în acest domeniu. 

Această carte prezintă o serie de aplicații în domeniul transferului termic prin conducție, convecție 

și radiație. Este destinată studenților, masteranzilor, doctoranzilor precum și inginerilor care vor să 

utilizeze modelarea matematică în studiul acestor procese cu ajutorul calculatorului.  
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Deși reprezintă doar un mic eșantion al vastelor tipuri de activități din acest domeniu, cartea va servi 

cu siguranță ca un instrument pentru cei interesați să pună bazele simulării numerice cel puțin în 

domeniul transferului termic.  

Aplicațiile dezvoltate în capitolele următoare abordează cu precădere situații din domeniul clădirilor 

și care au legătură cu viața cotidiană. De la înțelegerea modului în care are loc transferul termic de 

tip conductiv printr-un perete plan multistrat sau a transferului termic prin punțile termice, modul 

în care se pierde energia termică printr-un geam de tip termopan până la înțelegerea transferului 

de căldură prin convecție și radiație, această carte își propune, tratarea tuturor acestor subiecte din 

punct de vedere al simulării numerice la un nivel accesibil pentru orice inginer care își dorește o 

dezvoltare în această direcție. 

  



5 
 

 
 

Cuprins 

Cuvânt înainte ...................................................................................................................................... 3 

Cuprins ................................................................................................................................................. 5 

1 Modulul 1 – Introducere în simularea numerică Simularea numerică a conducției termice  prin 

pereți multistrat uniformi  Caz particular: Peretele unei locuințe .................................................... 11 

1.1 Generalități .......................................................................................................................... 12 

1.2 Cerințe ................................................................................................................................. 13 

1.2.1 Obiective ...................................................................................................................... 13 

1.2.2 Etapele studiului prin simulare numerică .................................................................... 13 

1.2.3 Proprietăți termice pentru materiale de construcție .................................................. 14 

1.3 Preanaliza ............................................................................................................................ 17 

1.4 Pornirea aplicației ................................................................................................................ 17 

1.5 Geometria ............................................................................................................................ 18 

1.6 Grila de calcul ...................................................................................................................... 24 

1.7 Configurarea cazului numeric ............................................................................................. 26 

1.7.1 Alocarea materialelor pentru straturile din care este compus peretele ..................... 26 

1.7.2 Impunerea condițiilor la limită ..................................................................................... 29 

1.7.2.1 Generalități despre condiții la limită .................................................................... 29 

1.7.2.2 Condiția la limită pentru față rece a peretelui ..................................................... 29 

1.7.2.3 Condiția la limită pentru față caldă a peretelui .................................................... 30 

1.7.2.4 Condiția la limită pentru partea de sus și cea de jos a domeniului de calcul ....... 31 



6 
 

1.8 Calculul soluției numerice ................................................................................................... 32 

1.9 Prelucrarea rezultatelor ...................................................................................................... 32 

1.9.1 Câmpul de temperatură ............................................................................................... 32 

1.9.2 Determinarea valorii și locației temperaturii maxime și minime ................................ 35 

1.9.3 Câmpul de flux de căldură ........................................................................................... 37 

1.9.4 Reprezentarea unui profil de temperatură prin domeniul de calcul ........................... 38 

1.9.4.1 Crearea dreptei utilizate pentru extragerea valorilor de temperatură ................ 38 

1.9.4.2 Extragerea profilului de temperatură ................................................................... 40 

1.9.4.3 Reprezentarea în Excel a profilului de temperatură ............................................ 41 

1.10 Validarea soluției numerice prin compararea cu soluția analitică globală ......................... 43 

1.11 Creșterea numărului de elemente din grila de calcul ......................................................... 44 

2 Modulul 2 – Simularea numerică a conducției termice  prin pereți neuniformi.  Caz particular: 

Puntea termica ................................................................................................................................... 46 

2.1 Generalități .......................................................................................................................... 47 

2.2 Contextul actual .................................................................................................................. 48 

2.3 Cerințe ................................................................................................................................. 51 

2.3.1 Obiective ...................................................................................................................... 51 

2.3.2 Etapele studiului prin simulare numerică .................................................................... 51 

2.4 Proprietăți materiale ........................................................................................................... 52 

2.5 Geometria ............................................................................................................................ 52 

2.6 Grila de calcul (Mesh) .......................................................................................................... 55 

2.7 Configurarea cazului ............................................................................................................ 56 

2.7.1 Configurarea proprietăților de material ...................................................................... 56 

2.7.2 Impunerea condițiilor la limită ..................................................................................... 59 

2.8 Calculul ................................................................................................................................ 60 

2.9 Rezultatele ........................................................................................................................... 60 

2.9.1 Distribuția de temperatură .......................................................................................... 60 

2.9.2 Distribuția fluxului de căldură prin perete ................................................................... 62 

2.9.3 Coeficientul global mediu de transfer de căldură........................................................ 64 

2.9.4 Extragerea profilelor de temperatură .......................................................................... 64 

2.9.4.1 Profilul de temperatură din zona neafectată de puntea termică ........................ 64 

2.9.4.2 Profilul de temperatură din zona cu puntea termică ........................................... 68 

2.10 Realizarea unei grile de calcul cu un număr mai mare de elemente .................................. 69 



7 
 

2.11 Verificarea influenței numărului de elemente față de soluția numerică obținută ............. 71 

3 Modulul 3 - Studiu prin simulare numerica - Convecția liberă  Grila de calcul de tip 

nestructurat  Caz particular: Transferul de căldură printr-o fereastra de tip termopan .................. 74 

3.1 Generalități .......................................................................................................................... 75 

3.2 Cerințe ................................................................................................................................. 76 

3.2.1 Obiective ...................................................................................................................... 76 

3.2.2 Etapele studiului prin simulare numerică .................................................................... 76 

3.3 Preanaliza ............................................................................................................................ 77 

3.4 Geometria ............................................................................................................................ 77 

3.5 Grila de calcul (Mesh) .......................................................................................................... 82 

3.5.1 Grila de calcul nestructurată -  cu elemente tetraedrale (primul mesh) ..................... 82 

3.5.2 Grila de calcul nestructurată -  cu elemente tetraedrale (al doilea mesh) .................. 84 

3.6 Configurarea/Setarea cazului .............................................................................................. 91 

3.6.1 Setări generale ............................................................................................................. 91 

3.6.2 Modelele numerice ...................................................................................................... 92 

3.6.3 Configurarea materialelor ............................................................................................ 93 

3.6.4 Definirea domeniului ................................................................................................... 95 

3.6.5 Condițiile la limită (boundary conditions).................................................................... 96 

3.6.6 Definirea reziduurilor ................................................................................................... 99 

3.6.7 Inițializarea soluției ...................................................................................................... 99 

3.7 Calculul .............................................................................................................................. 100 

3.8 Postprocesarea rezultatelor .............................................................................................. 102 

3.8.1 Crearea unui plan median pentru vizualizarea rezultatelor ...................................... 102 

3.8.2 Reprezentarea unui câmp de temperatura în planul median al modelului analizat . 103 

3.8.3 Reprezentarea distribuției de temperatura pe fața caldă și cea rece a geamului 

termopan .................................................................................................................................. 105 

3.8.4 Reprezentarea unui câmp de viteză .......................................................................... 106 

3.8.5 Reprezentarea unui câmp de vectori de viteză ......................................................... 107 

3.8.6 Reprezentarea grafică a unui profil de temperatură/viteză ...................................... 108 

3.8.7 Determinarea fluxului de căldură care străbate geamul termopan .......................... 116 

3.8.8 Determinarea coeficientului global de transfer termic pentru geamul termopan ... 117 

3.9 Verificarea modului în care grila de calcul poate să afecteze/influențeze soluția ........... 117 

3.9.1 Reprezentarea unui câmp de temperatură corelat cu grila de calcul ....................... 117 



8 
 

3.9.2 Reprezentarea unui câmp de viteză corelat cu grila de calcul .................................. 120 

4 Modulul 4 - Studiu prin simulare numerica - Convecția liberă  Grila de calcul de tip structurat 

Caz particular: Transferul de căldură printr-o fereastra de tip termopan....................................... 122 

4.1 Refacerea grilei de calcul prin utilizarea unei grile de tip structurat ................................ 123 

4.1.1 Cerințe ........................................................................................................................ 123 

4.1.2 Analiza/Preanaliza ...................................................................................................... 123 

4.1.3 Geometria .................................................................................................................. 124 

4.1.4 Grila de calcul (Mesh) ................................................................................................ 124 

4.1.4.1 Operațiunea de discretizare geometrica a laturilor care reprezintă adâncimea 

straturilor de aer .................................................................................................................. 125 

4.1.4.2 Operațiunea de discretizare geometrica a laturilor care reprezintă lățimea 

straturilor de aer .................................................................................................................. 126 

4.1.4.3 Operațiunea de discretizare geometrica a laturilor care reprezintă lungimea 

(înălțimea) straturilor de aer................................................................................................ 127 

4.1.4.4 Operațiunea de discretizare geometrica a laturilor care reprezintă grosimea 

sticlelor 129 

4.1.4.5 Operațiunea de discretizare geometrica a laturilor care reprezintă lățimea și 

lungimea sticlelor ................................................................................................................. 130 

4.1.5 Configurarea cazului .................................................................................................. 132 

4.1.6 Calculul ....................................................................................................................... 133 

4.1.7 Postprocesarea........................................................................................................... 133 

4.1.7.1 Distribuția de temperatura ................................................................................. 133 

4.1.7.2 Câmpul de viteză................................................................................................. 134 

4.1.8 Compararea profilelor de temperatură din cazurile cu grila structurată și cea 

nestructurată ............................................................................................................................ 137 

4.1.9 Compararea câmpurilor de temperatura și viteză din cazurile cu grila structurată și 

nestructurată ............................................................................................................................ 138 

4.2 Determinarea zonei unde va apărea fenomenul de condensare pe suprafața feței calde a 

geamului termopan ...................................................................................................................... 139 

5 Modulul 5 – Studiu prin simulare numerică.  Simularea numerică a radiației termice și a 

convecției naturale  Caz particular: Încălzirea de tip radiativ într-o încăpere ................................. 145 

5.1 Generalități ........................................................................................................................ 146 

5.2 Cerințe ............................................................................................................................... 147 

5.2.1 Obiective .................................................................................................................... 147 

5.2.2 Etapele studiului prin simulare numerică .................................................................. 147 



9 
 

5.2.3 Parametrii de lucru..................................................................................................... 148 

5.3 Preanaliza .......................................................................................................................... 149 

5.4 Configurarea zonei de lucru .............................................................................................. 149 

5.5 Geometria .......................................................................................................................... 150 

5.6 Salvarea cazului ................................................................................................................. 155 

5.7 Denumirea suprafețelor .................................................................................................... 156 

5.8 Realizarea grilei de calcul (mesh) ...................................................................................... 157 

5.9 Configurarea cazului .......................................................................................................... 159 

5.9.1 Calculul paralel ........................................................................................................... 159 

5.9.2 Activarea forței gravitaționale ................................................................................... 160 

5.9.3 Schimbarea unităților de măsură ............................................................................... 162 

5.9.4 Modelele numerice .................................................................................................... 162 

5.9.4.1 Ecuația energiei .................................................................................................. 162 

5.9.4.2 Modelul pentru curgerea vâscoasă .................................................................... 163 

5.9.4.3 Modelul pentru radiația termică ........................................................................ 163 

5.9.5 Configurarea materialelor .......................................................................................... 165 

5.9.5.1 Fluidul de lucru ................................................................................................... 165 

5.9.5.2 Materialele solide ............................................................................................... 166 

5.9.6 Condițiile de operare (operating conditions) ............................................................ 169 

5.9.7 Condițiile la limită (Boundary Conditions) ................................................................. 170 

5.9.7.1 Pereții interiori .................................................................................................... 171 

5.9.7.2 Peretele exterior ................................................................................................. 173 

5.9.7.3 Tavanul ................................................................................................................ 174 

5.9.7.4 Podeaua .............................................................................................................. 175 

5.9.7.5 Peretele corpului de încălzire ............................................................................. 175 

5.9.7.6 Impactul utilizării condițiilor la limită de tip wall multistrat asupra grilei de calcul.

 176 

5.10 Configurarea parametrilor numerici ai soluției ................................................................. 176 

5.11 Configurarea reziduurilor pentru variabilele calculate ..................................................... 177 

5.12 Configurarea unor puncte de monitorizare a valorilor calculate ...................................... 178 

5.12.1 Identificarea zonelor monitorizate ............................................................................ 178 

5.12.2 Crearea punctelor pentru monitorizare .................................................................... 178 

5.12.3 Configurarea punctelor de monitorizare ................................................................... 182 



10 
 

5.13 Inițializarea soluției ........................................................................................................... 183 

5.14 Calculul soluției.................................................................................................................. 184 

5.15 Convergența și stabilitatea soluției ................................................................................... 184 

5.16 Evaluarea rezultatelor ....................................................................................................... 188 

5.16.1 Câmpul de temperatură ............................................................................................. 189 

5.16.2 Câmpul de viteză ........................................................................................................ 190 

5.16.3 Câmpul vectorial de viteză ......................................................................................... 191 

5.16.4 Izosuprafețe ............................................................................................................... 192 

5.16.5 Reprezentarea fluxului de căldură ............................................................................. 196 

5.16.5.1 Fluxul de căldură radiat de sursa de căldură ...................................................... 196 

5.16.5.2 Fluxul de căldură de pe pereți ............................................................................ 196 

5.16.6 Evaluarea fluxurilor de căldură .................................................................................. 197 

5.16.6.1 Fluxul de căldură total ........................................................................................ 197 

5.16.6.2 Fluxul de căldură radiativ .................................................................................... 198 

5.16.6.3 Ponderea fluxurilor de căldură ........................................................................... 198 

5.16.7 Temperatura medie a aerului din încăpere ............................................................... 198 

5.16.8 Temperatura medie a pereților din încăpere ............................................................ 199 

5.16.9 Reprezentarea unui profil de temperatură................................................................ 199 

5.16.9.1 Crearea dreptei pentru extragerea profilului ..................................................... 199 

5.16.9.2 Extragerea profilului de temperatură ................................................................. 200 

5.16.9.3 Reprezentarea în Excel a profilului de temperatură .......................................... 202 

 

  



11 
 

 

 

1 Modulul 1 – Introducere în simularea numerică 

Simularea numerică a conducției termice  

prin pereți multistrat uniformi  

Caz particular: Peretele unei locuințe 

 

 

 

 

 

 

 

 

 

Program utilizat: Ansys 

Pachet: Steady State Thermal  

Geometria: Space Claim 

Mesh: Ansys Meshing 

Solver: Mechanical ADPL 

Postprocesare rezultate: Mechanical, Microsoft Office Word și Excel   
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1.1 Generalități 

În acest modul s-a lucrat cu versiunea de program Ansys 2020 rev2.  

În versiunile următoare ale programului Ansys este posibil ca anumite comenzi sau butoane să difere 

față de această versiune. 

Se consideră o locuință pe timp de iarnă. În locuință există o sursă de căldură care furnizează un flux 

de căldură constant care acoperă pierderile de căldură. 

O presupunere importantă este că această locuință este perfect etanșeizată, deci fluxul de căldură 

care va fi schimbat intre interiorul locuinței și mediul exterior se realizează doar prin procesul de 

conducție termică. 

Căldura se transferă prin convecție atât de la mediul interior al locuinței la perete cât și de la perete 

la mediul exterior. 

Cazul considerat în acest modul constă în studiul transferului de căldură printr-un perete exterior 

al locuinței amintite mai sus.  

Se consideră peretele multistrat din figura de mai jos. 

Acesta are un număr de 4 straturi: tencuială la exterior, izolație termică, peretele propriu zis și un 

strat de tencuială interioară. 
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1.2 Cerințe 

1.2.1 Obiective 

1. Realizarea unei simulări numerice a transferului de căldură printr-un perete multistrat, cu 

scopul identificării fluxului de căldură care se pierde prin suprafața peretelui. 

2. Determinarea coeficientului global de transfer termic pentru peretele plan. 

3. O înțelegerea cât mai riguroasă a rolului și importanței fiecărei etape în simularea 

numerică.  

1.2.2 Etapele studiului prin simulare numerică 

1. Să se identifice elementele de construcție. 

2. Să  se poarte o discuție în etapa de preanaliză cu scopul identificării strategiei de urmat în 

această simulare numerică.  

3. Să  se realizeze geometria în aplicația Ansys Student în pachetul Steady State Thermal 

utilizând programul SpaceClaim. 

4. Să  se realizeze grila de calcul (mesh). 

5. Să  se definească materialele care intra în componența schiței furnizate anterior. 

6. Să  se identifice în geometria de lucru zonele cu materiale diferite și să se aloce materialul 

potrivit pentru fiecare dintre acestea. 

7. Să  se definească condițiile la limită. 

8. Să  se ruleze cazul cu condițiile date. 

9. Să  se reprezinte grafic distribuția de temperatură. 

10.  Să se reprezinte grafic distribuția de flux de căldură. Să se reprezinte câmpul vectorial pentru 

fluxul de căldură. 

11. Să se reprezinte grafic, un profil de temperatura prin perete prin utilizarea a 200 de puncte.  

12. Să se reprezinte grafic acest profil de temperatură în Excel.  

13. Să se reia simularea numerica cu o grilă cu mai multe elemente și să se repete toate etapele 

4-12 

14. Să  se compare rezultatele dintre cele doua simulări numerice și să se identifice deosebirile. 

Încercați, ca pe lângă rezultate, să aveți și discuții referitoare la acestea precum și concluzii 

cu privire la aceste rezultate. 

15. Opțional: Realizarea unei geometrii pentru situația în care se consideră mai multe straturi 

pentru peretele analizat, conform discuției din capitolul Preanaliza. 

16. Să se realizeze un raport într-un editor de text (Microsoft Office Word) care să detalieze 

punctele 1-14. 

17. Suplimentar: Să se realizeze simularea numerică pentru situația în care peretele analizat are 

în componența sa toate straturile de material care există în realitate (Ex: Glet, Vopsea 

lavabila, Tinci, Vopsea pentru exterior). Pentru grosimea acestor straturi și pentru 
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determinarea proprietăților de material necesare pentru această simulare numerică, utilizați 

căutarea online. 

18. Suplimentar: Să se compare rezultatele obținute în simularea numerică pentru peretele plan 

care are toate straturile componente cu rezultatele obținute prin simularea numerică a 

cazului inițial. 

19. Suplimentar: Refaceți geometria și implicit toată simularea numerică, pentru cazul în care 

termoizolația este montată la interiorul locuinței, pe fața caldă a peretelui exterior. Toate 

celelalte condiții se vor păstra neschimbate.  

20. Suplimentar: Comparând cu situația în care izolația a fost montată la exteriorul locuinței ce 

se observă pentru cazul în care izolația termică a fost montată pe peretele interior? Care 

sunt concluziile? Efectuați un studiu comparativ pentru această situație utilizând un tabel cu 

2 coloane in Word. 

1.2.3 Proprietăți termice pentru materiale de construcție 

Proprietățile materialelor necesare pentru acest studiu numeric se iau din Anexa A din Normativul 
C107-3. Fiecare student/cursant va primi materiale diferite față de colegii săi. Pentru aceasta se vor 
utiliza tabelele de mai jos. 
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Tabel Proprietăți Materiale pentru Izolații Termice 

Denumirea materialului Conductivitate termică 

[W/mK] 

Polistiren expandat 0.035 - 0.044 

Polistiren extrudat 0.033 - 0.035 

Vată bazaltică 0.034 - 0.038 
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1.3 Preanaliza 

În această etapă se vor purta discuții referitoare la cea mai bună modalitate de abordare a acestei 

simulări numerice a transferului de căldură prin peretele plan multistrat. 

Față de un perete real, se observă din figura prezentată anterior că apar anumite diferențe. De 

exemplu, se poate vedea că în figură nu sunt prezente toate straturile aferente unui perete real (de 

exemplu nu apar vopseaua decorativă pe exterior și vopseala lavabilă la interior, straturile de glet, 

plasa de pe izolația termică, tinciul).  

Caracteristica comună a acestor straturi, care nu sunt luate în considerare, este că grosimea lor este 

foarte mică, și conform relației care descrie transferul de căldură prin conducție în perete, se vede 

că influența straturilor acestea subțiri asupra fluxului de căldură prin perete este foarte mică, în 

situația aceasta alegând să neglijăm aceste straturi.   

Se poate încerca construcția unei geometrii care să aibă unele sau chiar toate aceste straturi și să se 

facă o comparație a fluxului de căldură care traversează peretele și a coeficientului global de transfer 

de căldură comparativ cu situația prezentată în prima partea a acestui modul (Vezi cerințe).  

Se observă că datorită configurației peretelui (perete plan, multistrat), se poate încerca o 

configurație 2D, asupra unei zone restrânse din geometria peretelui multistrat prezentată anterior. 

Prin această alegere, atât timpul de calcul, cât și capabilitățile computaționale necesare pentru acest 

studiu vor fi mai scăzute, ceea ce poate să fie un avantaj în multe situații. 

O secțiune prin peretele analizat este prezentată mai jos. Se observă tencuiala exterioară, izolația 

termică, peretele locuinței și tencuiala interioară. 

 

1.4 Pornirea aplicației 

1. Din Taskbar se apasă butonul de start. Se derulează până la programul Ansys și se alege 

Workbench 

2. în Taskbar în bara de Search se caută programul Workbench și se dă click pe acesta.  

Se va deschide o fereastră asemănătoare cu cea de mai jos. 



18 
 

 

Se dă dublu click pe Steady State Thermal din panoul din stânga → Analysis Systems.  

În Project Schematic se va deschide fereastra Steady State Thermal. Se observă că aceasta va afișa 

etapele prin care se va trece în mod obligatoriu pentru realizarea acestei simulări numerice.  

 

1.5 Geometria 

Primul pas care trebuie realizat este să se selecteze opțiunea ca simularea numerică să se realizeze 

în 2D. 

Pentru aceasta se dă click dreapta pe Geometry → Properties. 
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În partea dreapta a apărut panoul Properties of Schematic A3: Geometry. De la Advanced Geometry 

Options → Analysis Type → 2D. 

 

Următoarea etapă este să se salveze Proiectul nou creat. Se va da o denumire reprezentativă care 

să includă și numele studentului/cursantului. 

Se dă click dreapta pe Geometry pentru a vedea că în cadrul acestui pachet (Steady State Thermal)  

există două aplicații tip CAD pentru construcția de geometrii. Se va alege SpaceClaim. (Dacă se va 

da dublu click pe Geometry, se va deschide SpaceClaim, deoarece este programul CAD implicit 

utilizat de către Ansys). 
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Din SpaceClaim se va seta unitatea de măsură în care se va lucra (ex: mm) din File → SpaceClaim 

Options → Units → Length → Milimeters.  

 

 

Se dă click pe pictograma Select New Sketch Plane din bara de jos. 
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În funcție de zona unde se duce cursorul mausului se poate selecta planul în care se dorește să se 

lucreze. Se va selecta planul XY. 

 

 

 

Se dă click pe pictograma Plan View din bara de jos. 
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Din Meniul Sketch se aleg uneltele (de exemplu se poate utiliza comanda Rectangle) cu care se vor 

crea 4 dreptunghiuri înălțimea de 100mm și cu lățimea de 5...10mm pentru tencuiala exterioară, 

80...150mm pentru izolația termică, 300...400mm pentru structura peretelui și 15...25mm pentru 

tencuiala exterioară. Dimensiunile exacte și materialele utilizate vor fi distribuite în cadrul orelor 

aplicative. 

 

Un exemplu de modalitate de lucru poate să fie: Se alege unealta Rectangle și se dă click în 0,0. Va 

apărea o imagine asemănătoare cu cea de mai jos. 
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În continuare, nu se va da al doilea click. Se observă că în partea de jos a dreptunghiului nou creat, 

valoarea cotei este cu albastru, semn că se poate suprascrie valoarea dorită.  

Se execută această operațiune și se apasă tasta Tab. Cursorul se va muta în câmpul corespunzător 

cotei verticale. Se suprascrie valoarea din căsuță cu valoare corectă și se apasă tasta ENTER. 

Următorul dreptunghi se va executa în același mod, având grijă însă ca primul click să se dea pe 

colțul din dreapta jos al dreptunghiului creat la pasul anterior. 

Se repetă această operațiune pentru toate dreptunghiurile. 

 

În bara de jos se va da click pe pictograma Return to 3D Mode. 

Înainte să se închidă SpaceClaim, se va selecta fiecare dreptunghi se va detașa de restul geometriei 

(click dreapta pe acel dreptunghi și se selectează comanda Detach). 

 

Denumirea fiecărei fețe se poate efectua în această etapă. În loc de denumirea Surface, se va 

schimba cu o denumire care să reflecte tipul suprafeței selectate (De exemplu: tencuiala exterioara 

sau termoizolație sau etc...). 



24 
 

 

Operațiunea de redenumire a suprafețelor poate să fie efectuată și în etapa de configurare a 

cazului numeric. 

1.6 Grila de calcul  

Din fereastra principală din Workbench se dă dublu click pe Model. 

 

Geometria creată în etapa anterioară (Geometry) a fost importată în această etapă nouă. Poate să 

fie vizionată în imaginea de mai jos. 

  

Se poate încerca un mesh implicit, în această situație. 

Pentru asta se dă click dreapta pe Mesh → Update.  
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Grila de calcul generată în acest mod, poate să fie vizualizată mai jos: 

 

Numărul de elemente pentru grila de calcul de mai sus este de 252.  

O primă observație legată de grila de calcul creată anterior este că liniile care formează grila de 

calcul nu sunt drepte, ceea ce în anumite situații poate să influențeze soluția numerică într-o 

oarecare măsură. 

Pentru evitarea acestui lucru, se poate crea un mesh conform prin aplicarea unei noi comenzi prin 

click dreapta pe Mesh → Insert → Face Sizing. 

 

Din Details of “Face Meshing” → Geometry se selectează cu tasta +ctrl apăsată cele 4 fețe 

componente ale geometriei de interes.  



26 
 

Se observă că la Method este selectată opțiunea Quadrilaterals (patrulatere). 

 

Se dă din nou click dreapta pe Mesh → Update. 

 

Se observă că grila de calcul generată acum arată mai uniformă. 

Se va continua cu acest mesh mai departe. 

1.7 Configurarea cazului numeric 

1.7.1 Alocarea materialelor pentru straturile din care este compus peretele 

De pe pagina principală a proiectului, din Workbench -  se intra în Engineering Data.  
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Se alege Add new material și se denumește materialul nou creat.  

În această simulare numerică se consideră că materialele sunt izotrope și că fiecare dintre materiale 

are o conductivitate termică constantă. 

Se observă că materialul implicit este “Structural Steel”, dar acesta nu poate fi utilizat pentru această 

simulare numerică deci se impune crearea altor materiale cu conductivitatea termică necesară 

pentru definirea acestor straturi. 

Se va da dublu click pentru fiecare material creat pe “Isotropic thermal conductivity” și se definește 

valoarea conductivității termice pentru materialul nou creat.  

(Fiecare student/cursant va avea materiale diferite, preluate din capitolul Proprietăți termice pentru 

materiale de construcție.) 
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Se repetă operațiunea pentru fiecare material care intră în componența peretelui analizat în acest 

studiu. 

După ce au fost definite toate materialele, se revine în fereastra principala a proiectului și se dă click 

dreapta pe Model → Update, pentru ca toate modificările efectuate anterior să fie luate în 

considerare în etapele următoare.  

 

În continuare se vor aloca materialele nou create, zonelor corespunzătoare din peretele analizat.  

Se selectează pe rând fiecare strat de material din Tree. În panoul de Details se selectează la 

Assignment, materialul corespunzător, definit anterior in modul Engineering Data.  

Un exemplu poate să fie văzut mai jos. 
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1.7.2 Impunerea condițiilor la limită 

1.7.2.1 Generalități despre condiții la limită  

Condițiile la limită (boundary conditions) sunt elemente extrem de importante în simularea 

numerică deoarece sunt principala modalitate prin care utilizatorul poate să configureze cazul la 

care lucrează prin simulare numerică.  

Condițiile la limită descriu parametrii/mărimile pe frontiera domeniului de interes, această 

informație de pe frontieră propagându-se în domeniul de calcul prin intermediul modelului 

matematic din cadrul programului de simulare numerică. 

Evident, că dacă condițiile la limită nu vor fi suficient de bine configurate/alese, și rezultatele 

obținute vor avea de suferit. În limba engleză expresia consacrată în domeniul CFD pentru acest 

lucru este “Garbage IN, Garbage OUT!”. Adică, dacă se vor introduce date de intrare/condiții la limită 

neconforme și rezultatele obținute vor fi greșite / neconforme / departe de realitate. În această 

situație, principalul răspunzător va fi utilizatorul și nu modelul matematic. 

Tipurile de condiții la limită care se pot impune în modulul de Steady State Thermal sunt 

următoarele: 

 

1.7.2.2 Condiția la limită pentru față rece a peretelui 

În situația de față, pentru impunerea condițiilor la limită se va alege Convecție pentru fața caldă și 

cea rece a peretelui deoarece, aceasta descrie cel mai bine și în realitate transferul de căldură dintre 

aerul din încăpere și perete, sau dintre aerul exterior și peretele locuinței. 

Pentru aceasta se dă click dreapta pe Steady State Thermal → Insert → Convection. 
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În fereastra de Details la Condiții la Limită se vor introduce valorile individuale care au fost alocate 

în cadrul aplicațiilor.  

Primul pas este să se aleagă dreapta (Edge) căreia i se alocă această condiție la limită. În situația de 

față dreapta selectată va fi cea din stânga care corespunde de altfel feței reci a peretelui analizat. 

Se va redenumi condiția la limită de convecție pentru fața rece a peretelui în “Convecție_exterior”. 

Un exemplu de configurare, pentru condiția la limită pentru fața rece a peretelui se poate vedea 

mai jos, unde coeficientul de convecție termică la exterior (film coefficient) are valoarea de 

23W/m2K iar temperatura aerului exterior (Ambient temperature) are valoarea de -18℃. 

 

1.7.2.3 Condiția la limită pentru față caldă a peretelui 

Se dă click dreapta pe Steady State Thermal → Insert → Convection. 

Și în această situație, primul pas este să se aleagă dreapta (Edge) căreia i se alocă această condiție 

la limită. În situația de față dreapta selectată va fi cea din dreapta care corespunde de altfel feței 

calde a peretelui analizat. 

Se va introduce o nouă condiție la limită de convecție pentru fața caldă a peretelui și se va redenumi 

condiția la limită în “Convecție_interior”. 
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Un exemplu de configurare, pentru condiția la limită pentru față caldă a peretelui se poate vedea 

mai jos, unde coeficientul de convecție termică la interior (film coefficient) are valoarea de 8W/m2K 

iar temperatura aerului exterior (Ambient temperature) are valoarea de 22℃. 

 

 

 

1.7.2.4 Condiția la limită pentru partea de sus și cea de jos a domeniului de calcul 

Pentru partea de sus și de jos a geometriei se va alege condiția la limită de tip “flux de căldură egal 

cu zero” deoarece fluxul de căldură se transmite prin perete de la față peretelui cu temperatura mai 

mare la cea cu temperatura mai mică. Pe direcție transversală, prin perete, fluxul de căldură, în 

această situație va fi astfel, nul. 

Se vor alege dreptele (Edges) cărora li se alocă această condiție la limită. În situația de față dreptele 

selectate vor fi cele de sus și jos din domeniul de calcul. Acestea sunt 8 și corespund câte 2 fiecăruia 

din cele 4 zone distincte care descriu domeniul de calcul.  

Dreptele vor fi selectate cu tasta +ctrl apăsată, dând click pe fiecare din cele 8 drepte. La unele dintre 

ele, va fi nevoie de operațiunea de zoom pentru a ușura selectarea dreptelor. 

Se dă click dreapta pe Steady State Thermal → Insert → Perfecly Insulated pentru a defini o condiție 

la limită prin care fluxul de căldură este zero (perete adiabat). 

Se va redenumi condiția la limită în “Heat_flow_perete_adiabat”. 

Se observă că fluxul de căldură are valoarea zero în această situație. 
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1.8 Calculul soluției numerice 

Se dă click dreapta pe Solution → Solve sau în bara de sus se dă click pe Solve. 

 

1.9 Prelucrarea rezultatelor 

1.9.1 Câmpul de temperatură 

Pentru generarea unui câmp de temperatură pentru domeniul calculat, se dă click dreapta pe 

Solution → Insert → Thermal → Temperature. 

Se redenumește din “Temperature” în “Camp_temperatura”. 
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Pentru afișarea valorilor de temperatură, se dă click dreapta pe câmpul de temperatură nou creat 

și se alege “Evaluate all results”. 

 

Câmpul de temperatură implicit va arăta ca în exemplul de mai jos: 

 

Pentru reprezentarea a mai multor valori/nuanțe de temperatură se dă click, de exemplu pe 

valoarea cea mai mare din legenda din stânga a figurii și se apasă pe butonul “+” de câte ori este 

necesar pentru introducerea unei noi valori de temperatură intermediare, delimitatoare, sau până 

când nu mai apare această opțiune (vezi figura de jos). 
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Se observă că în imaginea de mai sus, distribuția de temperatură este reprezentată clar dar nu se 

observă foarte bine temperatura din fiecare zonă.  

Pentru suprapunerea acestor zone peste harta de distribuție de temperatură se dă click în meniul 

Result → Edges → Show Underformed WireFrame, ca în imaginea de mai jos. Se observă acum, 

distribuția temperaturii corelată cu fiecare material din care este compus peretele analizat. 

 

Pentru afișarea unei distribuții de temperatură mai realiste, fără pragurile reprezentate mai sus, se 

dă click în meniul Result → Contours → Smooth Contours, ca în imaginea de mai jos. Se observă 

acum, distribuția mai realistă a temperaturii corelată cu fiecare material din care este compus 

peretele analizat. 
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1.9.2 Determinarea valorii și locației temperaturii maxime și minime 

O modalitate ușoară de a găsi temperatura maximă și minimă în domeniul de calcul, este să se 

activeze butoanele de Maximum și de Minimum. 

Totodată, prin activarea butonului Probe se poate citi temperatura oriunde în domeniul de calcul 

oriunde este prezent cursorul mausului.  

 

Dacă se va da click, cu comanda Probe activata, oriunde în domeniul de calcul, valoarea de 

temperatură din acea zonă, se va imprima în câmpul de temperatură sub forma unei etichete. Se 

pot pune în acest mod, oricât de multe etichete de temperatură în orice zonă din domeniul de 

interes. 
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Etichetele, puse în etapa anterioară pot să fie mutate sau șterse prin activarea butonului Label, 

încercuit cu roșu în imaginea de mai jos. Cu butonul Label activat, dacă se dă click pe o etichetă, se 

poate șterge cu tasta DELETE sau se poate muta prin utilizarea tehnicii drag & drop, cu mausul. 

 

Totodată, din panoul Details of “Camp_temperatura” creat anterior, se poate citi valoarea maximă 

și cea minimă de temperatura, precum și zonele unde acestea se manifestă. De asemenea se poate 

vedea temperatura medie a peretelui.  

 



37 
 

1.9.3 Câmpul de flux de căldură 

Pentru generarea unui câmp de temperatură pentru domeniul calculat, se dă click dreapta pe 

Solution → Insert → Thermal → Total Heat Flux. 

Se redenumește din “Total Heat Flux” în “Camp_flux_caldura”. 

 

Si aici se dă click dreapta pe “Camp_flux_caldura” și se alege Evaluate All Results. 

 

Va apărea câmpul de vectori de flux de căldură. Se observă ca fluxul de căldură are o valoare 

constantă în tot domeniul. Cum vă explicați această situație? 

 

Eventuale modificări în reprezentarea câmpului de vectori se pot efectua prin utilizarea elementelor 

de control din bara de sus. 
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Prin debifarea opțiunii de reprezentare vectorială, din imaginea de mai sus, se obține câmpul de flux 

de căldură. Și aici se observă că valoarea este constantă și uniform reprezentată în tot domeniul de 

calcul. 

 

Și dacă se face o interogare a panoului de Details aferent “Camp_flux_caldura” se vede același 

lucru. 

 

1.9.4 Reprezentarea unui profil de temperatură prin domeniul de calcul 

Primul pas în reprezentarea unui profil de temperatură este crearea unei drepte (path/căi), care va 

fi utilizată cu unicul scop de a extrage valorile de temperatură care sunt pe traseul dreptei 

respective. 

1.9.4.1 Crearea dreptei utilizate pentru extragerea valorilor de temperatură 

Se dă click dreapta pe Model → Insert → Construction Geometry → Path. 

Se schimba denumirea Căii create în “Cale_temperatura”. 
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Valorile care definesc dreapta creată se pot vedea în fereastra de Details de mai jos. 

Se observă că modul de crearea al căii trasate anterior a fost de tipul “Two Points”. Numărul de 

puncte de prelevare de temperatură impus este 198, dar dat fiind faptul încă 2 puncte reprezintă 

valorile de pe față caldă și cea rece a peretelui, rezultă că numărul total de puncte de pe această 

dreapta este 200. 

Atenție, la faptul că geometriile individuale de lucru pot să aibă grosimi diferite deci, valoarea 

punctelor care definesc cele 2 puncte ale dreptei pot să aibă valori diferite de la caz la caz.  

 

E important de reținut ca această dreaptă are unul din puncte pe față rece a peretelui și cel de-al 

doilea punct pe față caldă a peretelui. Să se verifice localizarea precisă a punctelor care definesc 

dreapta prin efectuarea operațiunii de mărire a reprezentării grafice (zoom). 
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1.9.4.2 Extragerea profilului de temperatură  

Pentru extragerea profilului de temperatură, se procedează la fel ca în cazul câmpului de 

temperatură, adică se dă click dreapta pe Solution → Insert → Thermal → Temperature. 

 

Se schimba denumirea în “Profil de temperatură”. 

Ceea ce va diferi însă este modalitatea de reprezentare a mărimii alese. La Scoping Method se va 

alege Path iar în fereastra de dedesubt la Path se va alege Calea creată anterior. 

Se va da click dreapta pe “Profil de temperatură” și se va alege Evaluate All Results.  

 

Se va da click dreapta pe “Profil de temperatură” și se va alege Evaluate All Results.  

În imaginea de mai jos este reprezentată calea (path) creată anterior colorată în funcție de 

temperatură. 

Se observă o reprezentare a profilului de temperatură jos, iar în dreapta jos este un tabel cu cele 

200 de valori de temperatură corelate cu grosimea peretelui unde apar aceste valori de 

temperatură. 
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Cu ajutorul mausului se pot modifica dimensiunile ferestrelor. Nu e recomandata închiderea lor. Se 

vede acum, mult mai clar, profilul de temperatură și cele doua coloane cu coordonatele și 

temperatura aferentă profilului de temperatură. 

 

1.9.4.3 Reprezentarea în Excel a profilului de temperatură 

Pentru reprezentarea grafică a profilului de temperatură într-un program specializat sau chiar în 

Excel, este necesară copierea celor 2 coloane în acel program.  

Pentru aceasta, cea mai simplă modalitate este să se selecteze cu mausul prima linie a celor 2 

coloane, se derulează cu la finalul listei și acolo ținând  tasta Shift apăsată se selectează ultima linie.  

Se copiază (Ctrl + C), se deschide programul Microsoft Excel, de exemplu, și se lipește/paste (Ctrl + 

V). 
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Se poate insera un cap de tabel, ca în imaginea de mai jos. Se poate transforma unitatea de măsură, 

în funcție de preferințe și se poate genera un grafic pentru profilul de temperatură importat mai 

devreme. 

Pentru aceasta se dă click pe Insert → Charts → Scatter → Scatter with Smooth Lines sau alt tip de 

grafic la alegere. 

 

Graficul astfel obținut va arăta ca cel din exemplul de mai jos. 

 

Ce concluzie aveți cu privire la variația temperaturii prin fiecare strat de material din care este 

alcătuit peretele? 

Construirea acestui grafic în Excel devine foarte importantă atât din punct de vedere al unei 

prezentări a rezultatelor mai profesională, dar mai ales datorită faptului că Excel permite comparația 

mai multor profile într-un singur grafic, făcând astfel posibilă compararea mai rapidă și mai precisă 

a profilelor de temperatură din diferite situații, cazuri. 
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1.10 Validarea soluției numerice prin compararea cu soluția analitică globală 

Relația de calcul care caracterizează transferul de căldură printr-un perete plan multistrat se poate 

vedea mai jos: 

𝑞̇ = 𝑘 ∙ ∆𝑡   [
𝑊

𝑚2
] 

Unde  𝑞̇ reprezintă fluxul de căldură unitar prin perete, [W/m2]; 

 k este coeficientul global de transfer de căldură, [W/m2K]; 

 ∆𝑡 este diferența de temperatură dintre mediul ambiant interior și mediul exterior [K]. 

Relația de calcul pentru k este: 

𝑘 =
1

1
𝛼𝑒𝑥𝑡

+ ∑
𝛿𝑖

𝜆𝑖
+

1
𝛼𝑖𝑛𝑡

   [
𝑊

𝑚2𝐾
] 

Unde 𝛼𝑒𝑥𝑡 reprezintă coeficientul de convecție între perete și aerul exterior, [W/m2K]; 

 𝛼𝑖𝑛𝑡 reprezintă coeficientul de convecție între perete și aerul interior, [W/m2K]; 

 𝛿𝑖 este grosimea fiecărui strat de perete, [m], 

 𝜆𝑖 este conductivitatea termică a fiecărui strat de perete, [W/m K]; 

În exemplul prezentat în acest modul s-a lucrat cu următoarele valori pentru grosimea pereților și 

pentru conductivitate termică: 

Strat 
Grosime 
strat [m] 

Conductivitate 
termică [W/mK] 

Tencuială 
interioară 

0.006 1.7 

Polistiren 0.1 0.04 

BCA 0.35 0.4 

Tencuială 

exterioară 
0.02 1.7 

 

Valoarea coeficientului de convecție între perete și aerul exterior s-a considerat 23 W/m2K. 

Valoarea coeficientului de convecție între perete și aerul interior s-a considerat 8 W/m2K. 

Temperatura aerului exterior este -18℃. 

Temperatura considerată pentru aerului interior este 22℃. 
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Aplicând relația de calcul de mai sus pentru coeficientul global de transfer de căldură va rezulta: 

𝑘 =
1

1
𝛼𝑒𝑥𝑡

+ ∑
𝛿𝑖

𝜆𝑖
+

1
𝛼𝑖𝑛𝑡

=
1

1
23 +

0.006
1.7 +

0.1
0.04 +

0.35
0.4 +

0.02
1.7 +

1
8 

= 0.280996  
𝑊

𝑚2𝐾
 

 

Înlocuind pe k în relația pentru fluxul de căldură unitar prin perete va rezulta: 

𝑞̇ = 𝑘 ∙ ∆𝑡 = 0.280996 ∙ 40 = 11.23983 
𝑊

𝑚2
  

Ne reamintim că valoarea fluxului de căldură unitar prin perete obținut prin simulare numerică este 

11.24 W/m2. 

 

Se observă că valoarea fluxului de căldură unitar obținut prin ambele metode are practic aceeași 

valoare. Prin urmare soluția numerică este validată ca fiind una corectă cu ajutorul relațiilor de 

calcul.  

Acesta este un exemplu de validare a soluției numerice.  

Desigur că acest caz a tratat un model geometric simplu, și scopul modulului a fost de familiarizare 

cu metoda numerică descrisă în acest model. Cazurile care pot să fie tratate pot să fie mult mai 

complexe, o soluție analitică calculată de utilizator putând să fie imposibilă, și în acea situație, 

rezolvarea prin metode numerice devine singura opțiune. 

1.11 Creșterea numărului de elemente din grila de calcul 

Din punct de vedere analitic, o grilă de calcul ca cea anterioară (252 de elemente) ar trebui să fie 

suficientă pentru reprezentarea corectă a transferului de căldură prin conducție prin acest perete 

multistrat. Asta, deoarece ecuația conducției termice este una simplă, de gradul întâi iar variația 

temperaturii printr-un perete omogen și izotrop este liniară. Aceasta face posibilă determinarea 

temperaturii în orice punct din acel perete, cunoscând doar temperatura pe față rece, temperatura 

pe față caldă a peretelui, conductivitatea termică și grosimea stratului analizat. Totuși, în anumite 
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situații soluția numerică poate să aibă anumite abateri, din varii motive. Această deficiență poate să 

fie corectată prin crearea unui mesh cu un număr mai mare de elemente. 

Pentru aceasta, se dă click dreapta pe Mesh → Insert Sizing. 

Se selectează cu tasta +ctrl apăsată cele 4 fețe componente ale geometriei de interes în Geometry.  

La Type rămâne Element size cu dimensiunea de 5mm. Se reține faptul că Growth rate are valoarea 

implicită setată la 1.2.  

Behaviour va fi configurat cu valoarea Hard în loc de Soft. 

 

Numărul de elemente obținut astfel în situația acesta este de 1879. 

 

În continuare se poate recalcula soluția numerică obținută anterior. 

Etapele sunt aceleași ca în cazul anterior. Fiecare etapă se va realiza identic începând cu etapa de 

Configurare a cazului numeric. 
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2 Modulul 2 – Simularea numerică a conducției termice  

prin pereți neuniformi.  

Caz particular: Puntea termica 

 

 

 

 

 

 

 

 

 

 

Program utilizat: Ansys 

Pachet: Steady State Thermal  

Geometria: Space Claim 

Mesh: Ansys Meshing 

Solver: Mechanical ADPL 

Postprocesare rezultate: Mechanical, Microsoft Office Word și Excel  
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2.1 Generalități 

In acest capitol s-a lucrat cu rezultate care au fost obținute în versiunea de program Ansys 2020 

revision2.  

In versiunile următoare ale programului Ansys este posibil ca anumite comenzi sau butoane să difere 

față de această versiune. 

 

Cazul considerat în acest modul consta în studiul transferului de căldură printr-un perete 

multistrat cu punți termice. 

Se considera cazul din figura de mai jos. 

Dimensiunile se consideră cele din plan. 
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2.2 Contextul actual 

Clădirile reprezintă o provocare din punct de vedere a politicii UE privind eficiența energetică, 

deoarece ele sunt responsabile pentru aproximativ 40% din consumul total de energie din UE. 

Totodată clădirile, prin consumurile aferente și prin modul în care energia necesară funcționării 

clădirilor, acestea sunt responsabile  și pentru o mare parte din emisiile de dioxid de carbon (CO2). 

Comisia Europeană şi-a impus ca obiectiv să devină prima uniune/țară neutră din punct de vedere 

al emisiilor de CO2 până în 2050, ceea ce necesită reducerea emisiilor de CO2 în toate domeniile, 

inclusiv cel al clădirilor. 

Directiva 2010/31/UE privind performanța energetică a clădirilor impune statelor membre să 

elaboreze planuri naționale pentru creșterea numărului de clădiri al căror consum de energie este 

aproape egal cu zero, atât în cazul clădirilor noi, cât prin renovarea clădirilor existente. 

Această directivă reprezintă principalul instrument legislativ la nivelul UE pentru îmbunătățirea 

eficienței energetice a clădirilor.  

Un element-cheie al actului normativ comunitar îl reprezintă cerințele referitoare la clădirile al căror 

consum de energie din surse convenționale este aproape egal cu zero.  

În conformitate cu articolul 9 alineatul (1) din Directiva 2010/31/UE, statele membre „se asigură că: 

(a) până la 31 decembrie 2020 toate clădirile noi vor fi clădiri al căror consum de energie este 

aproape egal cu zero;  

şi  

(b) după 31 decembrie 2018, clădirile noi ocupate și deținute de autoritățile publice sunt clădiri al 

căror consum de energie este aproape egal cu zero." 

Întrebarea care se poate pune este: Ce înseamnă o clădire cu consum de energie aproape egal cu 

zero? 

Potrivit Legii nr. 372/2005, obligativitatea încadrării în categoria nZEB va fi aplicabilă tuturor 

clădirilor noi, independent de proprietarul acestora, pentru care recepția la terminarea lucrărilor se 

va efectua în baza autorizației de construire emise începând cu 31 decembrie 2020. 

LEGEA nr. 372 din 13 decembrie 2005 (*republicată*) 

privind performanța energetică a clădirilor 

EMITENT  

PARLAMENTUL ROMÂNIEI 

Publicat în  MONITORUL OFICIAL nr 868 din 23 septembrie 2020 

Extras 
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15. Clădire al cărei consum de energie este aproape egal cu zero - clădire cu o performanță 

energetică foarte ridicată, la care necesarul de energie pentru asigurarea performanței energetice 

este aproape egal cu zero sau este foarte scăzut și este acoperit astfel: 

a) în proporție de minimum 30%, cu energie din surse regenerabile, inclusiv cu energie din surse 

regenerabile produsă la fața locului sau în apropiere, pe o rază de 30 de km față de coordonatele 

GPS ale clădirii, începând cu anul 2021; 

b) proporțiile minime de energie din surse regenerabile, inclusiv cu energie din surse regenerabile 

produsă la fața locului sau în apropiere, pe o rază de 30 de km față de coordonatele GPS ale clădirii, 

pentru perioadele 2031-2040, 2041-2050 și după 2051, se stabilesc prin hotărâre a Guvernului; 

 

ORDIN nr. 386 din 28 martie 2016 

pentru modificarea şi completarea Reglementării tehnice "Normativ privind calculul termotehnic al 

elementelor de construcţie ale clădirilor", indicativ C 107-2005, aprobată prin Ordinul ministrului 

transporturilor, construcţiilor şi turismului nr. 2.055/2005 

EMITENT  

MINISTERUL DEZVOLTĂRII REGIONALE ŞI ADMINISTRAŢIEI PUBLICE 

Publicat în  MONITORUL OFICIAL nr. 306 din 21 aprilie 2016 
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Pe cale de consecință, pentru ca o clădire să aibă un consum aproape egal cu zero trebuie să 

îndeplinească în mod cumulativ următoarele 3 condiții: 

• Necesarul de energie pentru clădirea analizată trebuie să respecte valorile din Anexa 2, în 

funcție de categoria clădirii și de zona climatică unde este localizată această clădire (Anexa 

1). 

• Minimum 30%, din consumul clădirii este acoperit cu energie din surse regenerabile, inclusiv 

cu energie din surse regenerabile produsă la fața locului sau în apropiere, pe o rază de 30 de 

km față de coordonatele GPS ale clădirii, 

• Valorile emisiilor de CO2 aferente clădirii analizate vor respecta Anexa 2, în funcție de 

categoria clădirii și de zona climatică unde este localizată această clădire (Anexa 1). 

În scopul atingerii nivelurilor de performanță energetică nZEB pentru clădiri, trebuie acordată o 

atenție deosebita proiectării și realizării elementelor de anvelopă inclusiv la racordarea cu 

componentele instalațiilor aferente clădirii, pentru reducerea transferului termic prin elementele 

de tip punte termică și cel cauzat de infiltrațiile de aer. 

Fluxul de căldură pierdut prin elementele de construcție care constituie punți termice poate să aibă 

valori foarte mari relativ la fluxul total de căldură care se pierde dintr-o locuință pe timp de iarnă 

ceea ce face ca analiza punților termice să devină o necesitate pentru încadrarea construcțiilor în 

categoria clădirilor al cărei consum de energie este aproape egal cu zero.  
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2.3 Cerințe 

2.3.1 Obiective 

1. Realizarea unei simulări numerice a transferului de căldură printr-un perete multistrat, 

neuniform cu punți termice cu scopul identificării fluxului de căldură care se pierde prin 

suprafața peretelui. 

2. Determinarea coeficientului global de transfer termic pentru perete plan și pentru puntea 

termică. 

3. Efectuarea de diverse simulări numerice pentru diferite cazuri posibile din punct de vedere 

fizic. 

4. Înțelegerea cat mai bună a rolului și importanței fiecărei etape în simularea numerică de 

tip CFD.  

2.3.2 Etapele studiului prin simulare numerică 

1. Să se identifice elementele de construcție. 

2. Să se identifice cotele geometrice necesare pentru construcția geometrica și să se 

găsească/determine/identifice celelalte cote necesare. 

3. Să se realizeze geometria în aplicația Ansys Student în pachetul Steady State Thermal 

utilizând programul Space Claim. 

4. Să se realizeze grila de calcul (mesh). 

5. Să se definească materialele care intra în componenta schiței furnizate anterior. 

6. Să se identifice în geometria de lucru zonele cu materiale diferite și să se aloce materialul 

potrivit pentru fiecare dintre acestea. 

7. Să se definească condițiile la limita. 

8. Să se ruleze cazul cu condițiile date. 

9. Să se reprezinte grafic distribuția de temperatura 

10.  Să se reprezinte grafic distribuția de flux de căldură. Să se reprezinte câmpul vectorial pentru 

fluxul de căldură. 

11. Să se reprezinte grafic, un profil de temperatură prin perete într-o zona la alegere dar fără 

punte termică în imediata apropiere (0.5m) și un profil de temperatură între colțul exterior 

al clădirii și colțul interior al camerei analizate. Să se obțină profilul de temperatura 

reprezentat cu 100 de puncte. 

12. Să se reprezinte grafic aceste profile de temperatură în Excel.  

13. Să se reia simularea numerica cu o grilă cu mai multe elemente și să se repete toate etapele 

4-12 

14. Să se compare rezultatele dintre cele doua simulări numerice și să se identifice deosebirile. 

Încercați, ca pe lângă rezultate, să aveți și discuții referitoare la acestea și concluzii cu privire 

la aceste rezultate și discuții. 

15. Să se realizeze un raport într-un editor de text (Microsoft Office Word) care să detalieze 

punctele 1-14. 
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2.4 Proprietăți materiale 

Proprietățile materialelor necesare pentru acest studiu se iau din din Anexa A din Normativ C107-3. 
Fiecare student va primi materiale diferite față de colegii săi. Pentru aceasta se vor utiliza tabelele 
prezentate în primul modul (pag.14, capitolul Proprietăți termice pentru materiale) .  
În această simulare numerică se consideră că materialele sunt izotrope și că proprietatea de 

conductivitate termică este constantă pentru fiecare material. 

2.5 Geometria 

Se deschide pachetul Steady State Thermal din Ansys Workbench. 
 

 
 
Se da click pe Geometry și se alege în meniul de Proprietăți din partea dreaptă a ecranului (sau se 

dă click dreapta pe Geometry → Properties) opțiunea 2D la Advanced Geometry Options 

→Analysis Type →2D. 

 

Se dă dublu click pe Geometry sau click dreapta pe Geometry și se alege SpaceClaim. 

Se dă click pe File → SpaceClaim Options →Units → mm 
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Se dă click în bara de jos pe New Sketch Plane și se selectează planul XY dând click în regiunea din 

dreapta-sus a schiței din imaginea de mai jos.  

 

Se dă click pe Plain View din meniul de jos și se execută schița de mai jos, utilizând din meniul Sketch, 

uneltele puse la dispoziție.  

A se observa că schița de mai jos este ușor diferită față de planul indicat inițial. Pentru studiul 

comparativ al influenței unui stâlp de beton armat situat pe colț față de o poziție centrală s-a extins 

domeniul de calcul în așa fel încât să cuprindă și zona din dreapta. 
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După definitivarea schiței de mai sus se dă click în meniul din josul paginii pe Return to 3D Mode.  

Verificați daca toate suprafețele sunt închise (watertight). Daca nu sunt, probabil ca nu ați închis 

complet construcția geometrica anterioara. Dacă sunt zone neînchise, este necesar să se revină la 

schiță și să se corecteze aceste erori. 

 

 

Se dă click dreapta pe fiecare zonă și se alege Detach pentru fiecare zona individuala. Această 

operațiune se realizează deoarece se va dori impunerea unor materiale diferite mai târziu în aceste 

zone. 
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2.6 Grila de calcul (Mesh) 

Prima etapă este definirea individuală a fiecărei suprafețe, pentru o alocare ulterioară mai ușoară a 

proprietăților de material. 

 

Se va executa o grilă de calcul implicită cu comanda click dreapta pe Mesh în Tree Outline în partea 

stângă și se alege comanda Update.  
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Din meniul Details of Mesh se dă click pe Statistics și se identifică numărul de elemente 

corespunzător acestei grile de calcul. De exemplu, grila din imaginea de sus are un număr de 308 

elemente patrulatere. 

La curs s-a discutat despre motivația acestui fapt. Eventual, cu comanda Face Meshing se poate 

aranja grila să fie mai uniform. Pentru aceasta se dă click dreapta pe Mesh →Insert →Face Sizing. 

Se vor alege toate zonele unde se dorește aplicarea acestei opțiuni.  

Observați opțiunea preselectată de la Method → Quadrilaterals (patrulatere).  

 

2.7 Configurarea cazului 

2.7.1 Configurarea proprietăților de material 

Impunerea conductivității termice a materialelor constituente se efectuează intrând din pagina 

principala din Ansys Workbench în Engineering Data. 



57 
 

 

Se adaugă un nou material pentru fiecare material care intră în componența peretelui analizat (Click 

here to add a new material). 

Pentru fiecare material se va alege conductivitatea termică izotropică. 

 

 

Un exemplu de adăugare a unei material și a conductivității termice asociate poate să fie văzut mai 

jos. 
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Se poate ieși din Engineering Data.  

Atenție, pentru ca proprietățile de material nou introduse să se regăsească în meniul Model, este 

necesar să se dea comanda Update: Click dreapta Model →  Update. 

 

Se intră în Model și se asociază proprietățile de material definite anterior cu zonele definite în 

prima parte a etapei de Meshing.  

Click dreapta pe fiecare denumire de zonă din meniul Outline: Project → Model → Geometry → 

“Denumire Zona” iar din fereastra de Details → Material → Assignment se alege denumirea 

materialului definit în etapa anterioară.  

Un exemplu se poate urmări mai jos.  

 

Se repetă această operațiune pentru toate zonele din domeniul de calcul. 
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2.7.2 Impunerea condițiilor la limită 

Odată ce proprietățile de material au fost impuse pentru zonele din domeniul de calcul, se poate 

trece la operațiune de definire a condițiilor la limită. 

Astfel, pentru definirea lor, se începe cu zonele care descriu fața rece și fața caldă a peretelui. Se va 

dă click dreapta pe Steady State Thermal → Insert →Convection. 

 

 

În fereastra de Details se vor introduce parametrii care caracterizează aceste zone.  

Un exemplu de definire a unei condiții la limită poate să fie urmărit mai jos. 

 

La Geometry, pentru fiecare zonă se vor selecta acele Edges care caracterizează acele zone. 

La Film Coefficient se setează valoarea coeficientul de convecție aferent acelei zone iar la Ambient 

Temperature se setează valoarea temperaturii mediului ambiant din exteriorul acelei zone. 

Dat fiind faptul că se va analiza o situație de iarnă, parametrii care caracterizează aceste zone vor 

avea valori în intervalele: 
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• Temperatura interioara: 19...23℃ 

• Coeficient de convecție la interior: 5...10 W/mK 

• Temperatura exterioara: -20...-15℃ 

• Coeficient de convecție la exterior: 15...25 W/mK 

Secțiunile transversale pe perete care mărginesc extremitățile domeniului de calcul se consideră că 

au o valoare a fluxului de căldură egală cu zero, deoarece transferul de căldură se realizează pe 

direcție transversală prin perete. Pe direcție longitudinală valoarea fluxului de căldură va fi zero, 

condiție care va fi impusă ca și condiție la limită în aceste zone.  

 

2.8 Calculul 

Click dreapta pe Steady State Thermal și se alege Solve.  

 

2.9 Rezultatele 

2.9.1 Distribuția de temperatură 

Soluția a fost calculată. 

Pentru reprezentarea distribuției de temperatură se dă click dreapta pe Solution → Insert → 

Thermal → Temperature. 
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Se dă click dreapta pe rezultatul de Temperatura creat anterior și se apasă pe “Evaluate All 

Results”. 

 

Un exemplu de distribuție de temperatura poate să fie văzut mai jos: 
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Pentru vizionarea elementelor constituente ale domeniului de calcul se alege Show Underformed 

Wireframe din Edges iar pentru vizionarea distribuției de temperatură fără trepte se alege Smooth 

Contours din meniul de Contours. 

   

 

Un exemplu de distribuție de temperatură poate să fie văzut mai jos. 

 

2.9.2 Distribuția fluxului de căldură prin perete 

Pentru reprezentarea distribuției de temperatură se dă click dreapta pe Solution → Insert → 

Thermal → Total Heat Flux. 

Un exemplu de distribuție de câmp de flux de căldură prin peretele analizat poate să fie văzut mai 

jos. 
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Un exemplu de distribuție de câmp de vectori de flux de căldură prin peretele analizat poate să fie 

văzut mai jos. 

Pentru aceasta se alege Vectors din meniul Results. 

 

 

Tot în această etapă se poate vedea valoarea minimă, maximă și medie a fluxului de căldură prin 

peretele analizat.  
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Astfel, aceste informații vor fi prezentate în fereastra Details, împreună cu denumirea zonelor unde 

apar aceste valori minime și maxime. 

 

2.9.3 Coeficientul global mediu de transfer de căldură 

Cunoscând-se valoarea medie a fluxului unitar de căldură care străbate peretele se poate calcula 

valoarea coeficientului global de transfer termic. 

În cazul real al evaluării coeficientului global de căldură corectat aferent unei punți termice 

domeniul de interes se va întinde 1.2m împrejurul punții termice analizate. La fel de bine se poate 

evalua vizual, în simularea numerică zona de unde puntea termică nu mai influențează transferul de 

căldură prin perete. 

2.9.4 Extragerea profilelor de temperatură 

2.9.4.1 Profilul de temperatură din zona neafectată de puntea termică 

Pentru extragerea unui profil de temperatură, procedura presupune crearea unei linii în zona de 

unde se dorește extragerea acestui profil, după care se poate executa această comandă. 

Pentru aceasta, se dă click dreapta pe Model → Insert → Construction Geometry → Path. Se poate 

denumi aceasta cale (path) la libera alegere (în exemplul de față, calea a fost denumită „profil 

orizontal”). 



65 
 

 

În fereastra nou deschisă se vor completa coordonatele punctelor care definesc dreapta care va sta 

la baza extragerii profilului de temperatură. Pentru ușurință, se poate schimba unitatea de măsură 

din m în mm sau cm. Pentru aceasta se tastează în câmpul Quick Launch comanda Units și se va 

alege linia: mm, cm, etc.  

 

Valorile din imaginea de mai jos sunt orientative. Coordonatele punctelor care caracterizează 

dreapta construită se vor lua pentru fața caldă și fața rece a peretelui din acea zona.  

Cu comanda zoom se va verifica dacă linia a fost trasată în zona dorită. Daca nu este trasată conform 

instrucțiunilor se vor ajusta coordonatele punctelor impuse anterior. 

La opțiunea Number of Sampling Points se va trece 98. Asta înseamnă că profilul de temperatură 

care va fi extras va fi compus din 100 de valori de temperatură (98 + cele 2 capete). 
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Pentru extragerea profilului de temperatură se va da click dreapta pe Solution → Insert → 

Thermal → Temperature.  

 

În Details la Scoping Method se alege Path, iar la Path se alege calea creată în etapa anterioară. 

Se dă click dreapta în arbore la Solution → Temperature x și se alege Evaluate all Results.  

 

Se poate vedea mai jos zona de unde a fost extras profilul de temperatură. 
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În fereastra de Details se pot vedea anumite informații de interes care caracterizează această 

zonă. 

 

În partea de jos ecranului a apărut un grafic cu variația temperaturii prin peretele multistrat analizat. 

 

Se observă că în partea dreapta a acestui grafic, există un tabel. Datele din tabel o să fie copiate într-

un program de calcul gen Microsoft Excel pentru prelucrarea ulterioară a acestora.  

Pentru aceasta, se selectează cele 2 coloane și se dă comanda paste (lipește) într-un Excel.  

Reprezentarea grafică a profilului de temperatură din Excel (un exemplu), poate să fie văzută mai 

jos. 
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Scrieți concluziile voastre cu privire la graficul de mai sus. 

2.9.4.2 Profilul de temperatură din zona cu puntea termică 

Urmărind etapele din cadrul etapei precedente se va extrage un profil de temperatură din zona de 

colț a geometriei analizate. Poziția profilului din zona de colț se poate vedea în imaginea de mai jos.  

 

 

Valorile de temperatură reprezentative se pot vedea mai jos (un exemplu): 
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Un exemplu cu reprezentarea grafică a profilului de temperatură din Excel, poate să fie văzută mai 

jos. 

 

Scrieți concluziile voastre cu privire la graficul de mai sus. 

Pașii necesari pentru reprezentarea grafică în Excel sunt: 

1. Se copiază datele din Ansys în Excel (ambele coloane se selectează în același timp). 

2. Se introduce o line în partea superioară pentru capul de tabel și se denumește corespunzător (să 

nu se uite de unitatea de măsură). 

3. Se selectează ambele coloane, cu tot cu capul de tabel și se dă click în Insert → Charts → Scatter 

→ Scatter with smooth lines (de ex). 

2.10 Realizarea unei grile de calcul cu un număr mai mare de elemente 

Se recomandă verificarea soluției numerice obținute prin comparația rezultatelor din cazul anterior, 

cu rezultate obținute în aceleași condiții cu excepția utilizării unei grile de calcul cu un număr mai 

mare de elemente. 

Pentru aceasta se merge în Workbench și se dă comanda duplicate (dublează) la cazul creat anterior. 

Se face acest lucru deoarece se dorește evitarea riscului suprascrierii datelor calculate anterior. Cu 

această ocazie se poate denumi primul sistem cu valoarea numărului de elemente din grila de mesh, 

în cazul de față 308 elemente. 
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Se poate intra direct în Solution acum în al doilea sistem creat. 

Numărul de elemente din grila de calcul poate să fie mărit, dând click pe Mesh în Tree Outline și din 

Details de la Element Size se poate trece valoarea dorită. În acest exemplu, valoarea este de 25mm.  

Impunând o valoare medie de 25mm pentru elementele din grila de calcul, a rezultat o grilă de 

discretizare geometrică cu un număr de 6640 elemente, deci de aproape 22 de ori mai mare ca în 

cazul grilei de calcul precedente. 

 

În cazul studiilor de independență a soluției față de grila de calcul se recomandă o creștere graduală 

a numărului de elemente prin dublarea acestora. În situația de față, în scop demonstrativ, s-a ales 

varianta de mai sus. 

Se reiau calculele, neschimbând nimic altceva în afara grilei de calcul și se salvează aceleași imagini 

și rezultate ca în cazul grilei de calcul de mici dimensiuni. 
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2.11 Verificarea influenței numărului de elemente față de soluția numerică obținută 

Compararea rezultatelor numerice obținute prin simularea numerică a transferului de căldură pr in 

domeniul de interes discretizat cu numere diferite de elemente se va realiza într-un tabel într-un 

program tip Microsoft Word.  

Un exemplu este oferit mai jos. 

Grila de 308 elemente Grila de 6640 elemente 

  

Fig.1 Distribuția temperaturii în peretele analizat 

Observație: Nu se observă vreo modificare semnificativă în câmpul de temperatură dintre cele 

două grile de calcul  

  

Fig.2 Intervalul între care variază valorile de temperatura în domeniul de calcul 

Observație: Chiar dacă prin analizarea câmpurilor de temperatură, nu s-a observat vreo 

variație semnificativă a temperaturii în domeniul de calcul între cele două meshuri, în această 

comparație se observă că atât valoarea maximă cât și ce minimă variază între cele doua grile 

diferite de calcul. Mai mult decât atât, se poate observa o improbabilitate fizică în situația 

grilei de mici dimensiuni prin faptul că valoarea minimă a temperaturii pe față rece a peretelui 

este chiar mai mică decât valoarea temperaturii curentului de aer exterior, ceea ce este 

imposibil din punct de vedere fizic. Această eroare este însă numerică și are legătură cu 

numărul prea mic de elemente într-o zonă cu gradient neliniar mare de temperatură. 

Pe lângă reprezentarea și compararea mărimilor din tabelul anterior, să se compare, pentru cele 

două meshuri create anterior, și: 

• Distribuția fluxului de căldură 

• Câmpul de vectori de flux de căldură 

• Valorile de minim și maxim pentru fluxul de căldură din domeniul de calcul 

• Valoarea medie a fluxului de căldură 
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• Coeficientul global de schimb de căldură corectat 

• Profilele de temperatură în zona neafectată de puntea termică (grafic din Excel) 

• Profilele de temperatură în puntea termică (grafic din Excel) 

La fiecare comparație să se poarte o discuție după modelul din tabelul anterior. 

Se observă că prin compararea profilelor de temperatură nu este foarte clar dacă sunt diferențe 

între cele două meshuri. În situația aceasta, se recomandă suprapunerea graficelor unul peste 

celălalt. 

Aceasta se realizează dând comanda Copy pe graficul care reprezintă profilul de temperatură pentru 

meshul cu un număr mai mare elemente, după care se dă comanda Paste (lipește) peste graficul 

corespunzător meshului cu un număr mai mic de elemente. 

În imaginea de mai jos aveți doua exemple. 

Încercați să obțineți același tip de grafice. Aveți mai jos doua exemple. 
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Ce concluzii aveți? 
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3 Modulul 3 - Studiu prin simulare numerica - Convecția liberă  

Grila de calcul de tip nestructurat 

 

Caz particular: Transferul de căldură printr-o fereastra de tip termopan  

 

 

 

 

 

 

 

 

Program utilizat: Ansys 

Pachet: Fluid Flow (Fluent) 

Geometria: Design Modeler 

Mesh: Ansys Meshing 

Solver: Fluent 

Postprocesare rezultate: Fluent, Microsoft Office Word și Excel, Coolpack 
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3.1 Generalități 

In acest capitol s-a lucrat cu rezultate care au fost obținute în versiunea de program Ansys 2020 

revision2.  

In versiunile următoare ale programului Ansys este posibil ca anumite comenzi sau butoane să difere 

față de această versiune. 

 

Cazul considerat în acest modul constă în studiul transferului de căldură printr-o fereastră de tip 

termopan. 

Se consideră fereastra de tip termopan din figura de mai jos. 

Dimensiunile sale inițiale sunt: 1m x 0.5m 

 

Proprietățile materialelor necesare pentru acest studiu sunt: 

• Conductivitate termica sticla: 0.9 … 1 W/mK 

• Densitate sticla: 2500…2800 kg/m3 

• Căldura specifica sticla: 840 J/KgK 

• Grosime foaie geam: 4mm 

• Număr foi de geam: 3 

• Grosime strat de aer/argon: 13mm 

• Număr de straturi de aer/argon: 2 
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3.2 Cerințe 

3.2.1 Obiective 

1. Simularea numerică a transferului de căldură prin suprafața vitrată a unei ferestre tip 

termopan în scopul identificării fluxului de căldură care se pierde prin suprafață. 

2. Determinarea coeficientului global de transfer termic al geamului de tip termopan. 

3. Efectuarea de diverse simulări numerice pentru diferite cazuri posibile din punct de vedere 

fizic. 

4. Înțelegerea cat mai bine a rolului și importantei fiecărei etape în simularea numerica. 

Pentru aceasta, de mai multe ori, se ca reveni la una din etapele anterioare pentru o 

exemplificare cât mai buna. 

5. Înțelegerea importanței și a modului de realizare a unei grile de calcul suficient de bună 

pentru o simularea numerică cu constrângeri slabe. 

6. Înțelegerea diferențelor, a punctelor tari și a celor slabe, precum și a modului de 

construcție pentru grilele de calcul structurate și nestructurate. 

3.2.2 Etapele studiului prin simulare numerică 

1. Identificați domeniul de calcul și stabiliți o strategie pentru abordarea simulării numerice 

pentru acest caz. 

2. Pentru simularea numerica se va utiliza, din pachetul Ansys, pachetul Fluid Flow (Fluent). 

3. Geometria se va executa în programul Design Modeler în format 3D. 

4. Generați o grila de calcul (mesh) de tip nestructurat care să tina cont de faptul ca 2 din cele 

5 straturi sunt gaze și astfel grila de calcul trebuie să aibă un strat limită creat în apropierea 

tuturor pereților în contact cu gazul. 

5. În etapa de configurare a cazului, să se seteze cazul ținând cont de faptul ca se dorește 

surprinderea fenomenului de convecție naturala dintre foile de geam. 

6. Să se inițializeze soluția cu inițializarea de tip hibrid. 

7. Să se configureze toleranta reziduurilor soluției la valoarea 10e-05 pentru toate ecuațiile 

calculate în afara de cea a conservării energiei. 

8. Să se ruleze cazul pentru 500 de iterații. 

9. Să se reprezinte grafic distribuția de temperatura printr-un plan prin centrul modelului 

analizat și se observe modul în care căldura se transmite prin sticla și prin mediul gazos. 

Realizați același lucru și pentru suprafețele corespunzătoare fetei calde și rece ale ferestrei 

de tip termopan. 

10. Să se reprezinte grafic distribuția de viteza prin planul median creat anterior. 

11. Să se reprezinte grafic câmpul de vectori de viteza prin planul median creat anterior. 

12. Să se încerce reprezentarea grafică a altor mărimi interesante pentru surprinderea cât mai 

bună a fenomenului de convecție naturală dintre foile de geam. 

13. Să se reprezinte grila de calcul în același timp cu distribuția de viteza și să se identifice 

eventualele zone unde grila de calcul alterează/influențează semnificativ rezultatele. 
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14. Să se determine care este fluxul de căldură care se transmite prin ansamblul de tip 

termopan studiat  

15. Să se determine care este valoarea coeficientului global de transfer termic pentru situația 

studiata 

3.3 Preanaliza 

Identificați domeniul de calcul și stabiliți o strategie pentru abordarea simulării numerice pentru 

acest caz. O să se vorbească la curs despre aceasta etapa la care o să fie necesar să se revină de 

câteva ori pe parcursul acestui studiu prin simulare numerică. 

3.4 Geometria 

În acest studiu nu se va înainta pe calea ce mai ușoară ci ne vom întoarce ori de cate ori este 

nevoie la operațiunile anterioare pentru a configura cazul cat mai bine pentru aceasta situație. 

Această abordare are legătură cu faptul că se dorește încercarea și exersarea a mai multor metode 

de lucru în diverse etape ale simulării numerice. 

Se deschide pachetul Fluid Flow (Fluent) fie cu dublu click în meniul din stânga fie utilizând tehnica 

drag&drop cu mausul. 

Se va utiliza programul Design Modeler. Click dreapta pe Geometry și se alege acesta. Să vă asigurați 

că în proprietăți la Analysis Type este selectată opțiunea de 3D. 

 

Se setează unitatea de măsură în mm. 
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Se alege planul YZ și se creează o schiță în acesta. Cu comanda Look at Face/Plane/Sketch se 

aranjează modul de vizualizare al schiței nou create. 

In schița din meniul Sketching – Draw se alege Rectangle și se executa un dreptunghi având coltul 

din stânga jos în originea 0, 0. 
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Cu comanda Dimensions – General se dă click succesiv pe lungimea și lățimea dreptunghiului creat 

anterior, după care se cotează în meniul Details View corespunzător acestei comenzi de cotare.  

Se va cota H1: 500mm, V2: 1000mm. 

  

 

După cotarea dreptunghiului se executa comanda Extrude direct din schița creata anterior dând 

click pe iconița Extrude. Se extrudează conform indicațiilor din figura următoare. 
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Va rezulta astfel, foaia de geam exterioară care are grosimea de 4mm. 

În momentul în care se așază piesa creată în vedere izometrică, se va observa că din punct vedere 

al așezării acesteia, pare că este culcata, în loc să aibă înălțimea de 1000mm o are de 500mm. Nu 

este nicio problema, deoarece în simularea numerica se poate configura gravitația să acționeze pe 

ce direcție se dorește, doar că pentru a înțelege mai bine modul în care funcționează acest program 

și pentru a economisi timp mai târziu pentru vizualizări o să se schimbe înălțimea să fie 500mm. 

Pentru aceasta în meniul Tree Outline se dă click pe Sketch-ul în care este creat dreptunghiul și se 

schimba intre ele cotele, astfel cota H1 devine 1000mm iar V2: 500mm. 

Se da click pe Generate și se observa că atât schița, cat și corpul creat anterior s-au modificat. 

Se configurează denumirea și tipul de corp: 

 

În următoarea etapa, cea de creare a volumului de aer dintre sticla exterioara și sticla din mijloc se 

va utiliza o alta modalitate pentru generarea acestuia. 

Se da click, având selectorul de fețe (Faces) activat, pe față orientata în direcția X (pozitiv) și se apasă 

comanda Extrude. De data aceasta va trebui să se selecteze normala la suprafață, care poate să fie, 

de exemplu, unul din cele 4 Edge-uri de 4mm ale sticlei. Apăsând pe săgeți, se poate schimba sensul 

extrudării acestei fete. Extrudarea se face în direcția pozitiva a lui X, conform figurii de mai jos. 

Adâncimea stratului de aer va fi cel dat în cerințele aplicației. 
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Se configurează și în acest caz denumirea și tipul de material (fluid). 

 

În continuare, se vor obține și celelalte 3 straturi care intra în alcătuirea geamului termopan. 

Aceasta se va face, prin repetarea etapei anterioare de extrudare, dar având grija ca fața selectată 

pentru extrudare să fie acea față care se află în contact cu noul corp. 

Se va denumi fiecare corp pentru o mai ușoară identificare ulterioară a acestuia și se va aloca pentru 

fiecare dintre aceste corpuri proprietatea de fluid/solid în funcție de tipul de material din care este 

alcătuit stratul. 

Toate proprietățile celor 5 volume sunt prezentate mai jos. 
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3.5 Grila de calcul (Mesh) 

3.5.1 Grila de calcul nestructurată -  cu elemente tetraedrale (primul mesh) 

Cea mai la îndemână soluție, în acest program de executat grile de calcul, pentru crearea unui mesh 

în domeniul fluid, este utilizarea de elemente tetraedrale care sunt însoțite în apropierea pereților 

de câteva straturi de celule de tip prisme care sunt aliniate paralel cu pereții din considerente legate 

de curgerea fluidului de-a lungul peretelui. în cazul pereților solizi, numărul de elemente pe 

adâncimea peretelui, necesar pentru simularea numerica a transferului de căldură de tip conductiv 

poate să fie mult mai mic, teoretic putând să fie chiar un singur element daca peretele este omogen 

și izotrop deoarece ecuația conducției termice este liniară. 
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Se configurează ca dimensiunea generală a celulelor să fie de 6mm. Aceasta se realizează dând click 

pe Mesh iar în Details of Mesh va apărea opțiunea Element size care va trebui modificată. Alte 

opțiuni rămân nemodificate dar asigurați-vă de acest lucru comparând fereastra cu imaginea de mai 

jos. 

 

Din discuțiile avute la curs s-a înțeles ca, în domeniul de fluid se dorește crearea unui strat limită de 

celule prismatice care să poată să surprindă dinamica curgerii și a transferului de căldură în 

apropierea peretelui. 

Pentru aceasta se utilizează comanda Inflation. Click dreapta în Tree pe Mesh→Insert→Inflation. 

Pentru comanda Inflation se identifica volumul pe care se aplica aceasta comanda (atenție că 

selectorul de volume este ales în această etapă pentru selecția volumului cu un simplu click), iar în 

câmpul “Boundary” se aleg cele 6 fețe care alcătuiesc volumul selectat. Se recomanda să se lucreze 

succesiv cu cate un volum de aer.   

La Inflation Option se selectează opțiunea Total Thinkness cu Maximum Thinkness de 4.5mm. 

 

Se da click pe Update. 
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Imaginea de mai sus a fost obținută prin utilizarea comenzii Section Planes. 

 

Pentru o vizualizare mai bună, se poate secționa domeniul de calcul utilizând comanda New Section 

Plane din meniul Section Planes. Pentru o vizualizare completă a elementelor, nesecționate, se dă 

click pe butonul Show Whole Elements din meniul Section Planes (vezi imaginea de mai jos). 

 

3.5.2 Grila de calcul nestructurată -  cu elemente tetraedrale (al doilea mesh) 

O prima observație cu privire la calitatea meshului este că secțiunea prin grila de calcul relevă faptul 

numărul de elemente pe adâncimea startului de aer (11 elemente) și modul în care acestea sunt 

dispuse nu par să acopere nevoile pentru o grila de calcul suficient de calitativa descrisa în 

amănunțime la curs.  

Pe lângă aceasta, se observa că numărul de elemente pentru întreaga geometrie este mare, în 

condițiile în care doar un volum de aer este discretizat cu noua opțiune și astfel meshul a ajuns la 

un număr de ~500.000 elemente. Efectuând un calcul simplu se vede că dacă se va discretiza 

geometric întregul domeniu de calcul, numărul final de elemente va ajunge la ~1.000.000 și chiar și 

în condițiile acestea, grila de calcul nu pare să fie suficienta pentru o modelare numerica de calitate.  
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Ținând cont de faptul și de faptul că numărul maxim de elemente cu care se poate lucra în licența 

Ansys de tip Student pentru pachetul Fluid Flow este 512.000 trebuie să se reconsidere strategia 

pentru simularea numerica.  

Asta presupune să ne reîntoarcem la etapa de preanaliză. 

Se va încerca astfel reducerea numărului de elemente prin simplificarea și mai mult a întregului 

domeniu de calcul din punct de vedere geometric. 

Se observa că fereastra are o lățime de 500mm dar cum mișcarea aerului în fiecare cavitate este 

gravitațională, putem să presupunem că acea componenta de viteză care caracterizează mișcarea 

aerului pe lățimea ferestrei (Z Velocity) este foarte mică deci poate să fie considerată cu influență 

foarte mică în dinamica curgerii naturale între foile de geam. 

În consecința, strategia care se va aplica este să se studieze un geam de tip termopan de lățime mai 

mică, astfel se va alege ca noua lățime a geamului termopan să fie de 100mm, reducându-se astfel 

lățimea să de la 500mm.  

Astfel, se închide fereastra în care s-a încercat primul mesh (Ansys Meshing – programul în care se 

creează grila de calcul) și se intră din nou în Design Modeler, unde se dă click pe prima schiță creată. 

Aici se schimbă cota pentru lățimea dreptunghiului de la 500mm la 100mm. 

 

Se da click pe Generate și se poate ieși din aceasta fereastra. 

Se recomanda salvarea direct din Workbench cat mai des pentru a evita pierderea datelor. 

Se da dublu click pe Mesh în Workbench și se alege să se încarce în continuare modificările aduse 

anterior sau se dă click dreapta pe Mesh și se alege comanda Update. 
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După ce se intra în programul Ansys Meshing se reconsidera opțiunile anterioare. 

Astfel, pentru dimensiunea globală a elementelor din domeniul de calcul se va alege valoarea de 

5mm. 

 

Pentru cele doua volume de aer, comanda Inflation va fi configurată conform figurii de mai jos. 
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Se va mai aplica o comandă pentru cele doua volume de aer și anume comanda de Body Sizing care 

va controla dimensiunea locală a elementelor. În situația aceasta se va utiliza dimensiunea de 

3.9mm.  

Aceasta dimensiune va permite crearea unei grile apropiate de numărul maxim de elemente permis 

de licența de tip Student. 
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După  efectuarea acestor modificări, se face update la mesh iar grila de calcul rezultată pentru întreg 

domeniul de calcul va avea ~480.000 elemente. 

 

În continuare se pot vedea câteva imagini cu meshul rezultat. 
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Se observă, că deși numărul de elemente pe adâncimea fiecărui strat de aer este de 12, și exista 

anumite rezerve cu privire la calitatea acestui mesh, se va continua mai departe în simularea 

numerica cu acesta, tocmai pentru identificarea punctelor slabe pe care acesta le are.  

Daca, în etapa de postprocesare a rezultatelor se va observa că soluția calculată va fi una puternic 

influențată de mesh, atunci, ne vom întoarce la prima etapă și anume de preanaliză pentru a 

identifica o noua posibilă strategie pentru abordarea acestui caz. 

O etapă foarte importantă este cea de denumire a suprafețelor. 

Înainte de ieși din modulul de Meshing este necesara identificarea tuturor suprafețelor pentru a 

putea mai târziu, să se impună condițiile la limită pe aceste suprafețe. 

Aceasta operațiune se realizează în felul următor: 

• Se alege selectorul de fețe 

• Se selectează față dorita 

• Se da click dreapta pe aceasta 

• Se alege comanda Create Named Selection. 

• Se scrie denumirea pentru fața respectiva și se dă OK 
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• Se reia operațiunea pentru alta față. 

 

 

Pentru cazul curent, mai jos se poate vedea o sugestie de denumire a acestor fețe.  

Este important în această etapă să se aibă în vedere faptul că scrierea denumirii acestor fețe având 

în prima parte a numelui și tipul condiției la limită, scris într-un mod corect va duce la asocierea 

automata și corectă a unor proprietăți în etapa de configurare. Exemplu, în această situație este: 

„symmetry” unde este cazul.  

Toate fețele nedenumite, vor fi grupate într-un singur grup cu o denumire standard. Fiind într-un 

singur grup aceste fețe vor putea fi utilizate mai greu pentru o situație specifică, deci o sugestie ar 

fi să se încerce să se denumească toate fețele, din etapa aceasta. 

Modalitatea în care au fost denumite fețele în exemplul acesta poate să fie văzută mai jos: 

• Față orientata către X pozitiv va fi denumită Față_calda_termopan. 

• Față orientata către X negativ va fi denumită Față_rece_termopan. 

• Fețele orientate către Z pozitiv vor fi denumite Symmetry_stanga (5 fețe). 

• Fețele orientate către Z negativ vor fi denumite Symmetry_dreapta (5 fețe). 

• Fețele orientate către Y pozitiv vor fi denumite Wall_sus (5 fețe). 

• Fețele orientate către Y negativ vor fi denumite Wall_jos (5 fețe). 
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În acest moment, toate fețele exterioare care mărginesc domeniul de calcul sunt denumite. 

 

 

3.6 Configurarea/Setarea cazului 

3.6.1 Setări generale 

Ținând cont de faptul că se cunoaște că transferul de căldură o să se realizeze conductiv prin foile 

de geam și convectiv între stratul de aer și foile de geam și de faptul că procesul de convecție 

naturală este influențat și controlat de variația densității gazelor în funcție de temperatura acestora 

și de mișcarea naturală a acestor gaze într-un câmp gravitațional, se impune ca aceste condiții să fie 

definite și în cazul numeric.  

Astfel, prima dată se va afișa geometria/meshul care a fost importată din etapa anterioară. 

  

Avantajul poziționării inițiale a domeniul de calcul după cum se vede în imaginea de mai sus, se 

observa prin faptul că nu mai e nevoie să se execute alte comenzi pentru afișarea corectă a imaginii 

din punct de vedere al câmpului gravitațional. Astfel, se observă că gravitația acționează pe direcția 

negativa a axei Y. 
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Pentru aceasta vom seta valoarea și sensul accelerației gravitaționale după cum reiese din figura de 

mai jos. 

 

În această etapă se poate configura ca simularea numerică să fie realizată în regim nestaționar sau 

se determină dacă modelarea numerică se poate simplifica astfel încât să fie abordată din punct de 

vedere al unui regim staționar.  

Regimul staționar se definește ca starea în care toate variabilele de stare din domeniul de interes 

(presiune, temperatura, viteza, etc.) rămân constante în pofida faptului că există procese în 

desfășurare în acel domeniul de interes. De exemplu în cazul de față unde există atât curgere cât și 

transfer de căldură, se poate face presupunerea că valorile de temperatură, presiune, viteză, 

precum și alte variabile din curgere rămân constante în timp pentru orice punct din domeniul de 

calcul investigat. 

Spre deosebire de regimul staționar, regimul nestaționar presupune o variație în timp a variabilelor 

de stare în domeniul de interes. 

În cazul de față se va selecta regim staționar (Time -- Steady). 

3.6.2 Modelele numerice 

Deoarece studiul presupune transfer de căldură prin conducție și convecție, se vor activa cele doua 

module necesare simulării numerice și anume: 

• Modulul Energy (Ecuația conservării energiei) 

• Modulul Viscous pentru curgerea studiata  

Modelul vâscos ales va fi cel pentru curgerea laminara deoarece avem convecție libera intre doi foi 

de geam. Mai târziu se va putea verifica dacă într-adevăr curgerea este una laminară. Vezi figura de 

mai jos. 
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3.6.3 Configurarea materialelor 

Următorul Meniu și anume cel de Materials cuprinde zona unde vor fi definite proprietățile 

termofizice ale materialelor care vor fi utilizate în aceasta simulare numerica (sticla și aer). 

Proprietățile termofizice pentru aer pot să fie urmărite mai jos. Atenție la faptul că densitatea 

aerului nu este considerata constanta, după cum este setata implicit ci este calculată conform 

legilor gazului ideal (ecuația de stare). 

În această etapă are loc definirea fluidului şi materialului solid (dacă este cazul). În funcţie de tipului 

fluidului, din biblioteca Fluent-ului se poate alege dintr-o mare diversitate de materiale sau se poate 

configura un material nou, putându-se schimba proprietăţile care caracterizează fluidul, precum şi 

legea după care acestea variază. 

De exemplu, în cazul în care există variaţii mici de presiune în curgere, dar variaţiile de temperatură 

sunt mari, este recomandată utilizarea legii gazului ideal incompresibil pentru variaţia densităţii. 

Această opţiune calculează densitatea în funcţie doar de temperatură. Utilizată în cazurile potrivite, 

această opţiune influenţează pozitiv convergenţa soluţiei, fără a sacrifica din precizia de calcul. 
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Se observă că materialul solid utilizat în Fluent în mod implicit este Aluminiul. Se verifică dacă există 

în baza de date a programului, materialul sticlă (glass). 

 

Se observă că sticla (glass) nu este prezentă în baza de date deci este necesar să fie introdusă 

manual. Pentru aceasta se revine în meniul Aluminiului și se modifică proprietățile și numele 

acestuia. Se va șterge simbolul acestuia (chemical formula) și se vor introduce datele pentru sticlă 

care sunt date în introducerea acestui capitol. 

Proprietățile termofizice necesare în aceasta simulare pentru sticlă pot să fie văzute și mai jos. 
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Se dă click pe Change/Create, se confirmă schimbarea după care se închide fereastra. 

3.6.4 Definirea domeniului 

Următoarea comanda din Tree se refera la Cell Zone Condition. Dacă fiecare din cele 5 volume a fost 

definit corect în etapa de execuție a Geometriei ca Fluid sau Solid, în aceasta etapă, se poate doar 

verifica daca alocarea materialului s-a efectuat în mod corect. Ținând cont de faptul că avem un 

singur material definit la fluide și unul singur la solide, în mod automat, programul va aloca aer la 

tot ce a fost definit anterior ca fluid și sticla la tot ce a fost definit anterior ca solid. Vezi mai jos. 
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Daca s-a uitat sau s-a alocat greșit zona de fluid/solid anterior, acum se poate modifica din fereastra 

Task Page de mai sus. se dă click pe volumul căruia i-a fost alocata greșit proprietatea și din bara de 

jos se dă click pe Type alegându-se proprietatea corectă. 

In momentul în care a fost setat modul de calcul al densității ca fiind gazul ideal, programul a furnizat 

un mesaj „Warning: For compressible (ideal and real) gas models with buoyancy,  it is recommended 

that you use a specified operating density value of zero:  define/operating-conditions/operating-

density? yes 0.” Aceasta valoare se poate seta la 0 fie urmărind comenzile din mesajul afișat, fie din 

meniul Cell Zone Conditions se dă click pe Operating Conditons și de acolo la Variable Density 

Parameters se dă click pe bifa Specified Operating Density și se trece valoarea 0. 

 

3.6.5 Condițiile la limită (boundary conditions) 

Următoarea etapă este cea de configurare a condițiilor la limită (boundary conditions). 

Se va alege ca reprezentarea zonelor din meniul de condiții la limită să se efectueze în funcție de 

tipul zonei, pentru o vizualizare mai ușoară. (click Zone Type).  
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Se observă că scriind denumirea Symmetry pentru zonele laterale domeniului de calcul (în etapele 

anterioare), programul a alocat în mod direct condiția la limită de tip Symmetry acestor zone. Dacă 

denumirea nu este corectă și programul nu reușește să facă alocarea în mod automat, aceasta 

trebuie efectuata manual.  

Pentru aceasta se caută condițiile la limită cu denumirea dată anterior și dând click pe acea condiție 

la limită în meniul Task Page, se pot derula la Type, în josul paginii toate tipurile de condiții la limită 

care se pot aplica pe aceasta suprafață. Se observă că în situația aceasta, a fost aleasă condiția la 

limită de tip symmetry. 

 

Ținând cont de faptul că geamul termopan are o față caldă și una rece, apare necesitatea impunerii 

unor condiții la limită relevante pentru aceste doua suprafețe. 

Pentru ușurința în utilizare, se poate schimba unitatea de măsură și anume din meniul Domain – 

Units se alege Temperature și de acolo se dă click pe C (Celsius). Se observă că în program sunt 

predefinite patru unități de măsură pentru temperatură (Kelvin, Celsius, Rankine, Fahrenheit). 
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Astfel, pentru față caldă a geamului termopan, un exemplu de condiții la limită este dat mai jos. 

 

Iar pentru fața rece a geamului termopan, un exemplu este furnizat mai jos: 
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3.6.6 Definirea reziduurilor 

Reziduurile se setează din meniul Monitors – Residual. Se setează conform cerinței. 

 

3.6.7 Inițializarea soluției 

Înainte de a începe simularea numerică de tip CFD, celulele din grila de calcul trebuie iniţializate 

prin atribuirea unei valori inițiale de la care să înceapă calculul de tip iterativ.  

Se inițializează cazul cu metoda de tip hibrid. 
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3.7 Calculul 

Numărul de iterații se setează la 100 din meniul Run Calculation și se pornește calculul. Acesta va 

dura de la câteva minute la câteva ore, în funcție de performanța computațională a fiecărui 

calculator în parte.  

 

După 100 de iterații se observa că reziduurile au încă tendința de convergență, astfel că se mai 

rulează 100 de iterații. 
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După  alte 100 de iterații se pot observa din nou reziduurile în figura de mai jos. Se mai dau 300 de 

iterații, astfel încât să se ajungă la un număr de 500 de iterații. 
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3.8 Postprocesarea rezultatelor 

3.8.1 Crearea unui plan median pentru vizualizarea rezultatelor 

Se selectează Plane din meniul Surface (vezi figură) 

 

Se creează un plan median paralel cu planul XY (5cm). 
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3.8.2 Reprezentarea unui câmp de temperatura în planul median al modelului analizat 

Se poziționează vederea planului în așa fel încât să se vadă planul XY. 

Results → Contours → Temperature 

 

Se observa că nu se văd foarte clar diferitele zone care alcătuiesc geamul de tip termopan. 

Se da click în fereastra Contours pe Draw Mesh. 

 

Se alege doar planul median creat anterior și din meniul Options se alege Edges iar din Edge Type se 

alege Outline.  
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Se da click pe Display – Close iar când se revine în fereastra Contours se dă click din nou pe Display. 

 

Acum se observa mult mai clar distribuția de temperatura prin materialele diferite care alcătuiesc 

geamul termopan. 

Pentru ca în legendă, valorile de temperatură să fie reprezentate ca numere cu doua zecimale, se 

dă click pe Colormap Options în meniul de Contours și se alege Float având Precision 2. 
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3.8.3 Reprezentarea distribuției de temperatura pe fața caldă și cea rece a geamului termopan 

Vezi în figura de mai jos. Contours→Temperature  

Se debifează opțiunea de Global Range pentru a avea de la minim (Min) la maximum (Max) în figura 

afișată, doar temperatura de pe suprafață selectata. 

 

Programul oferă posibilitatea vizualizării unei zone mai mari decât cea calculata deoarece am utilizat 

condiția la limită de tip Symmetry și în condițiile acestea se poate obține un efect vizual mai 

interesant. 

View → Views  

 

 

Se selectează toate cele 10 fete definite ca Symmetry în meniul de Mirror Planes și se dă click pe 

Apply. 
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Se observă zona din suprafață geamului interior care este mai caldă și care este mai rece. 

Ce concluzii puteți să scrieți cu privire la zona cu temperatura mai scăzută? 

Distribuția de temperatura pe față rece a geamului termopan poate să fie văzută în figura de mai 

jos. 

 

 

3.8.4 Reprezentarea unui câmp de viteză 

Se poziționează modul de vizualizare pentru model în așa fel încât să se vadă planul XY. 

Results → Contours → Velocity → Velocity Y deoarece în felul aceasta valorile de viteza care sunt 

orientate în sensul axei Y vor fi reprezentate cu roșu iar cele opuse, cu albastru. 
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Se observa că aerul dintre foile de geam se ridica când e în apropierea foii de geam mai calde și se 

lasă când se apropie de foaia de geam mai rece, ca efect al modificării densității aerului care se 

încălzește în apropierea feței calde a geamului sau se răcește în apropierea feței reci a geamului. 

3.8.5 Reprezentarea unui câmp de vectori de viteză 

Results → Vectors 

Un exemplu de setări poate fi urmărit în figura de mai jos. 

Stilul de afișare al vectorilor se poate schimba din meniul Style. 

Pentru o vizualizare mai clară se poate micșora dimensiunea vectorului cu comanda Scale care poate 

să fie atât subunitară cât și supraunitară (vezi figura de mai jos). De asemenea, se pot afișa mai puțini 

vectori, în zonele aglomerate, setând Skip (vezi figura de mai jos).  
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3.8.6 Reprezentarea grafică a unui profil de temperatură/viteză 

Primul pas este crearea unei linii care va fi utilizată pentru extragerea valorilor parametrilor doriți 

din domeniul de calcul. Linia creată este una virtuală, nu va afecta în vreun fel soluția numerică, fiind 

utilizată doar în scopul reprezentării grafice a mărimilor urmărite. 

 

 

Se poate vedea linia nou creata în imaginea de mai jos. 
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Results → Plots → XY Plots 

Un profil de temperatura prin toate cele cinci straturi, extras cu ajutorul liniei create anterior în zona 

mediana se poate vedea mai jos. 

 

Valorile de temperatură se pot afișa în format normal dând click pe Axes și după aceea pe Axis Y. Se 

modifica la Type din “exponențial” în „float” pentru afișarea în mod normal (cu virgulă), și nu în 

format științific. 
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Pentru reprezentarea profilului de temperatură sub formă de curbă, în loc de puncte se poate da 

click pe Curves. 

 

Iar din Line Style Pattern se poate seta tipul de linie. 



111 
 

 

Se observa mult mai clar acum, modul în care fiecare material influențează transferul de căldură. Ce 

observați? 

Pentru transferarea datelor extrase în alt software (de exemplu Microsoft Excel) se dă click în 

fereastra Solution XY Plot pe Write to File.  

In acest moment, va apărea butonul de Write. Se va da click pe el și se va salva fișierul „*.txt” în 

locația dorită. 

 

Pentru importarea acestor date în Excel se poate proceda După  cum urmează. 

Se deschide Excel, se dă comanda Open și se deschide locația unde a fost salvat fișierul anterior care 

conține profilul de temperatură. Se va selecta la tipul de fișiere All Files deoarece profilul de 
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temperatură nu a fost salvat într-un fișier nativ Excel. Se selectează fișierul salvat anterior și se apasă 

Open. 

Programul va returna un mesaj de genul: 

 

Se apasă Yes. 

 

Se alege Delimited și se apasă Next. 

Pe lângă Tab se mai selectează Space și se apasă Finish. 
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Se va deschide o fereastră Excel care va avea doua coloane, pe una fiind distanța în m și pe cealaltă 

temperatura în K. 

 

Eventuale operațiuni cu coloanele se pot executa în Excel, de exemplu transformarea în grade 

Celsius sau din m în mm. 

Se observă că datele sunt puse împrăștiat adică nu sunt aranjate După  distanță de exemplu. 
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Se pot aranja în ordinea dorită selectând coloana dorită (de exemplu, Distanța) și utilizând din 

meniul Data→Sort→Sort A to Z (lowest to largest) 

  

Se selectează Expand the selection. 

 

Reprezentarea în Excel se poate efectua după selectarea celor două coloane de interes (Distanța și 

Temperatura) și se selectează din Meniul Insert→Charts→Scatter→ Scatter with smooth lines 
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Avantajul reprezentării pofilelor pentru mărimi în alte programe este că se pot efectua comparații 

mult mai ușor între diferite cazuri studiate.  

Salvați fișierul Excel astfel creat deoarece va fi folosit într-o etapă ulterioară în cadrul acestui 

modul. Să îi dați numele “profil de temperature grila nestrucuturata.xlsx”. 

 

Urmând aceleași etape, reprezentați profilul de viteză utilizând aceeași linie creată la începutul 

acestei etape.  

Un exemplu de profil de viteză se poate vedea mai jos.  

Atenție, dacă se reprezintă Velocity Magnitude, doar componenta pozitivă a vitezei va fi 

reprezentată. 

Nu este greșit.  

Velocity magnitude se calculează ca rădăcina sumei pătratelor celor 3 componente ale vitezei deci 

întotdeauna Velocity magnitude va avea valoare pozitivă. 
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Reprezentarea componentei Y a vitezei este dată mai jos. 

 

Exportați atât profilul de viteza pentru magnitude Velocity cât și pentru Y Velocity în Excel și 

salvați fișierele cu denumirile:   

“profil de Velocity magnitude grila nestrucuturata.xlsx”. 

Și 

“profil de Y Velocity grila nestrucuturata.xlsx”. 

Și aceste fișiere vor fi utilizate într-o etapă ulterioară în cadrul acestui modul. 

 

3.8.7 Determinarea fluxului de căldură care străbate geamul termopan 

Reports→Fluxes→Total Heat Transfer Rate pentru Față caldă și cea rece a geamului termopan. 

Se observa să în situația aceasta un flux de 4.2W traversează aceasta suprafață vitrata. Prin fața 

caldă va intra un flux de căldură de 4.2W (pozitiv) iar prin fața rece a geamului termopan va ieși un 

flux de căldură de -4.2W (negativ).  

 

Cunoscându-se dimensiunile suprafeței vitrate: L=1m, l=0.1m rezulta că aria să este 0.1m2. 
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De aici rezultă că fluxul termic unitar are valoarea de  

𝑞̇ =
𝑄̇

𝑆
=

4.2

0.1
= 42  W/m2 

3.8.8 Determinarea coeficientului global de transfer termic pentru geamul termopan 

Cunoscând valoarea fluxului de căldură unitar și a diferenței de temperatură de o parte și de alta a 

geamului termopan se poate calcula valoarea coeficientului global de transfer termic. 

 

𝑞̇ = 𝑘 ∙ ∆𝑡   

 

𝑘 =
𝑞̇

∆𝑡
=  

42

(22−(−18)
= 1.05 [W/m2K] 

 

3.9 Verificarea modului în care grila de calcul poate să afecteze/influențeze soluția 

3.9.1 Reprezentarea unui câmp de temperatură corelat cu grila de calcul 

Se poziționează vederea modelului în așa fel încât să se vadă planul XY. 

Results→ Contours → Temperature 

 

Se observă că nu se văd cele cinci părți componente ale geamului termopan ceea ce face dificilă 

interpretarea rezultatelor. 

În consecință se vor introduce contururile tuturor straturilor care alcătuiesc domeniul de calcul. 
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Pentru aceasta, se dă click în fereastra contours din care s-a reprezentat câmpul de temperatură 

anterior pe Draw Mesh. 

 

Se alege doar planul median creat anterior și din meniul Options se alege Edges iar din meniul Edge 

Type se alege All.  

 

Se da click pe Display → Close iar când se revine în fereastra Contours se dă click din nou pe Display. 
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Se mărește imaginea (zoom) în domeniul de calcul pentru a se vedea clar corelarea dintre grila de 

calcul și mesh. 

Se observa că izotermele de temperatura urmăresc liniile și sau nodurile care formează grila de 

calcul fiind în mod clar influențate de către grila de calcul.  

Încercați să găsiți asemenea zone unde câmpurile de temperatură/viteză sunt influențate de către 

grila de calcul. 

 

Un detaliu mai clar poate să fie văzut mai jos. Se pot observa izotermele de temperatură care sunt 

influențate puternic de modul în care a fost construită grila de calcul. 
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Privind imagini ca cea anterioară, concluzia de bază este că nu se poate exclude ipoteza că soluția 

este una afectata de grila de calcul și că o soluție independentă de influența meshului s-ar putea 

obține doar dacă se modifica grila de calcul. Această modificare a meshului se poate realiza atât 

prin mărirea numărului de elemente, cât și prin schimbarea tipului de elemente din grila de calcul.  

3.9.2 Reprezentarea unui câmp de viteză corelat cu grila de calcul 

Se reprezintă la fel ca în cazul anterior doar că mărimea analizata este componenta pe Y a vitezei, 

asta deoarece dacă se reprezintă magnitudinea vitezei nu se poate vedea sensul mișcării pe 

verticală. Componenta pe Y a vitezei este interesant de reprezentat deoarece, mișcarea fiind 

preponderent verticală se poate vedea cu mare precizie distribuția câmpului de viteză. 

Se observa că în zonele de noduri, valoarea vitezei este mai mare, ceea ce poate să fie doar un efect 

numeric cauzat de distribuția grilei de calcul. 
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Un detaliu din câmpul de viteza corelat cu grila de calcul poate să fie văzut mai jos.  

 

Aceeași concluzie reiese și studierea imaginilor în care câmpul de viteza este corelat cu meshul și 

anume că nu se poate exclude ipoteza că soluția este una afectata de grila de calcul și că o soluție 

independenta de influenta meshului s-ar putea obține doar daca se modifica meshul. Această 

modificare a meshului se poate realiza atât prin mărirea numărului de elemente, cât și prin 

schimbarea tipului de elemente din grila de calcul. 
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4 Modulul 4 - Studiu prin simulare numerica - Convecția liberă  

Grila de calcul de tip structurat 

Caz particular: Transferul de căldură printr-o fereastra de tip termopan  

 

 

 

 

 

 

 

 

Program utilizat: Ansys 

Pachet: Fluid Flow (Fluent) 

Geometria: Design Modeler 

Mesh: Ansys Meshing 

Solver: Fluent 

Postprocesare rezultate: Fluent, Microsoft Office Word și Excel, Coolpack 
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4.1 Refacerea grilei de calcul prin utilizarea unei grile de tip structurat 

În acest modul se va continua modulul anterior. 

4.1.1 Cerințe   

1. Studiul 2: Să se genereze o grila de tip structurat și să se reia toate etapele de la 4 la 15.  

2. Să se realizeze comparații intre rezultatele obținute cu grila structurată față de cea 

nestructurată (Studiul 1 față de Studiul 2).  

3. Realizați un tabel care să conțină comparații sub formă de elemente grafice (imagini, 

profile) între cele doua grile de calcul. Pentru fiecare set de imagini să aveți, cel puțin o 

observație. Ce concluzii se pot trage? 

4. Să se determine zona unde va apărea condensul de apă pe față caldă a geamului termopan 

în condițiile date, considerând și anumiți parametrii pentru aerul interior (temperatura și 

umiditatea relativă) 

5. Suplimentar - Studiul 3: Înlocuiți aerul cu argon și reluați etapele 4-15.   

6. Suplimentar - Să se realizeze comparații sub forma unui tabel intre rezultatele obținute în 

studiul 2 față de studiul 3 (aer față de argon). Ce observații aveți? Care sunt concluziile? 

7. Suplimentar - Studiul 4. Să se schimbe fereastra de tip termopan din modelul cu 3 sticle și 

2 straturi de aer în varianta cu 2 sticle și 1 strat de aer. 

8. Suplimentar - Să se realizeze comparații sub forma unui tabel intre rezultatele obținute în 

studiul 2 față de studiul 4 (Tripan față de Termopan de tip vechi). Ce observații aveți? 

9. Pentru toate studiile individuale, inclusiv cele comparative, se vor realiza rapoarte într-un 

editor de texte (Microsoft Word). Se va încerca să se descrie cat mai clar fiecare etapa 

parcursa și să se poarte discuții la partea de comparații între cazuri. Se va încerca 

elaborarea unor concluzii proprii. 

4.1.2 Analiza/Preanaliza 

În situații ca aceasta, în care constrângerile sunt foarte slabe, curgerea fiind influențată doar de forța 

gravitațională, modul în care este construita grila de calcul are o importanta foarte mare, deoarece, 

grila nestructurată poate să influențeze într-o oarecare măsură rezultatele calculate. Constrângerile 

slabe duc la gradienți mici ale mărimilor din domeniul de calcul și astfel orice modificare într-o 

anumita zona, poate să duca la variații ale valorilor acestor mărimi (temperatura, viteza, densitate, 

presiune, etc.). Cu cat constrângerile sunt mai mari (ventilator/pompa de exemplu) cu atât aceasta 

influență va deveni mai puțin semnificativa. 

Prin urmare, se impune schimbarea grilei de calcul. 

Se deschide cazul cu grila de calcul cu elemente tetraedrale și se salvează cu alt nume pentru a 

putea păstra datele anterioare fără riscul ca s-ar putea pierde. La final se prezinta comparații între 

rezultatele obținute cu cele doua tipuri diferite de grile de calcul. 

O grila de calcul recomandată pentru asemenea situații este cea de tip structurat. Această 

modificare a meshului se poate realiza atât prin mărirea numărului de elemente, cât și prin 
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schimbarea tipului de elemente din grila de calcul. Deoarece, în situația aceasta, licența programului 

Ansys limitează cazurile studiate la un număr de maximum 512.000 elemente, soluția care se 

impune este crearea unei grile de tip structurat, care prin însăși structura ei va fi mai economică. 

Trebuie reținut că grila de tip structurat este de preferat altor tipuri de mesh din mai multe motive 

care vor fi discutate ulterior. 

O grilă de calcul de tip structurat este definită ca o grilă în care nodurile interioare au același număr 

de elemente în jurul lor. O caracteristică a grilei structurate este că aceasta urmează un model 

topologic dat, care este reprodus în toate direcțiile domeniului investigat (2D sau 3D). Spre 

deosebire de grila de tip structurat, grila de calcul de tip nestructurată este identificată printr-o 

conectivitate neregulată intre elementele alăturate. Nu poate fi exprimată cu ușurință ca un tablou 

bidimensional sau tridimensional în memoria computerului la fel ca în cazul grilei de calcul 

structurate.  

Principalul avantaj al grilei de tip nestructurat este că poate să mesheze orice element posibil 

geometric. Dat fiind faptul că din punct de vedere geometric, domeniul actual de calcul este format 

din 5 paralelipipede, rezultă că o grilă de calcul de tip structurat poate să fie implementată în această 

situație fără dificultăți mari. 

4.1.3 Geometria 

Nu este necesara modificarea geometriei din moment ce se dorește doar schimbarea grilei de 

calcul. 

4.1.4 Grila de calcul (Mesh) 

Se intra în modulul de Mesh și se dă click dreapta pe Mesh în 

fereastra Tree Outline și se alege Clear Generated Data pentru 

a ne asigura că se șterg toate setările anterioare.   

Strategia în aceasta situație este să nu se utilizeze comanda 

Inflation. Straturile de celule paralele cu peretele vor fi 

construite manual. 

Pentru aceasta se va începe de la nivelul de Edge (laturi) 

efectuându-se discretizarea geometrică pe fiecare astfel de 

Edge din domeniul de calcul. 

In primul rând se va genera meshul pentru volumele de aer. 

Pentru aceasta, se selectează din Tree Outline → Proiect → 

Model → Geometry  cu tasta Ctrl apăsată cele doua volume de 

aer, se dă click dreapta și se alege Hide all other bodies. 
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4.1.4.1 Operațiunea de discretizare geometrica a laturilor care reprezintă adâncimea straturilor de 

aer 

Cu selectorul de Edges ales, se selectează toate cele 8 Edges (laturi) care reprezintă adâncimea 

straturilor de aer (Fiecare volum de aer are 4 asemenea laturi). 

Se da click dreapta pe Mesh în Tree Outline și se alege Insert →Sizing. În Details la Geometry se dă 

click pe Apply. 

Se schimba numele în Edge Sizing Grosime Aer. 

In fereastra de Details se completează conform figurii de mai jos.  

Astfel la Numărul de diviziuni se alege valoarea de 20. Behaviour va fi Hard.  

Atenție când se alege Bias Type să se alega opțiunea cu elemente mai mici pe margini la ambele 

capete ale laturii. Se alege Smooth Transition pentru Bias Option iar la Bias Growth Rate se trece 

1.1.  

 

Așa va arăta distribuția meshului pe aceste linii (Edges) considerate.  
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4.1.4.2 Operațiunea de discretizare geometrica a laturilor care reprezintă lățimea straturilor de aer 

Cu selectorul de Edges ales, se selectează toate cele 8 Edges (laturi) care reprezintă lățimea (bazele) 

straturilor de aer (Fiecare volum de aer are 4 asemenea laturi). 

Se da click dreapta pe Mesh în Tree Outline și se alege Insert →Sizing. În Details la Geometry se dă 

click pe Apply. 

Se schimba numele în Edge Sizing Laturi. 

In fereastra de Details se completează conform figurii de mai jos.  

Dimensiunea elementelor va fi de 3mm. 

Behaviour va fi Hard.  

 

Așa va arăta distribuția meshului pe aceste linii (Edges) considerate.  
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4.1.4.3 Operațiunea de discretizare geometrica a laturilor care reprezintă lungimea (înălțimea) 

straturilor de aer 

Cu selectorul de Edges ales, se selectează toate cele 8 Edges (laturi) care reprezintă lungimea 

(înălțimea) straturilor de aer (Fiecare volum de aer are 4 asemenea laturi). 

Se da click dreapta pe Mesh în Tree Outline și se alege Insert →Sizing. în Details la Geometry se dă 

click pe Apply. 

Se schimba numele în Edge Sizing Lungimi. 

In fereastra de Details se completează conform figurii de mai jos.  

Dimensiunea elementelor va fi de 3mm. 

Behaviour va fi Hard.  

 

Așa va arăta distribuția meshului pe aceste linii (Edges) considerate.  
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Se poate genera un mesh de proba pentru a putea estima numărul de elemente din fiecare volum 

de aer. Se observa că numărul elementelor este de ~227.000 pentru fiecare volum de aer. 

 

Urmează generarea meshului pentru volumele care reprezintă cele 3 sticle. se dă click dreapta în 

fereastra cu geometria și se alege Show all bodies. 

Se selectează din Tree Outline → Proiect →Model →Geometry  cu tasta Ctrl apăsată cele trei sticle, 

după care se dă click dreapta și se alege Hide all other bodies. 
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4.1.4.4 Operațiunea de discretizare geometrica a laturilor care reprezintă grosimea sticlelor 

Cu selectorul de Edges ales, se selectează toate cele 12 Edges (laturi) care reprezintă grosimea 

sticlelor (Fiecare sticla are 4 asemenea laturi). 

Se da click dreapta pe Mesh în Tree Outline și se alege Insert →Sizing. În Details la Geometry se dă 

click pe Apply. 

Se schimba numele în Edge Sizing Sticle. 

In fereastra de Details se completează conform figurii de mai jos.  

Numărul de diviziuni impus va fi 3. 

Behaviour va fi setat ca Hard. 

 

 

 

Așa va arăta distribuția meshului pe aceste linii (Edges) considerate.  
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4.1.4.5 Operațiunea de discretizare geometrica a laturilor care reprezintă lățimea și lungimea 

sticlelor 

Cu selectorul de Edges ales, se selectează toate cele 12 Edges (laturi) care reprezintă grosimea 

sticlelor (fiecare sticla are 4 asemenea laturi). 

Se da click dreapta pe Mesh în Tree Outline și se alege Insert →Sizing. În Details la Geometry se dă 

click pe Apply. 

Se schimba numele în Edge Sizing Sticle Laturi. 

In fereastra de Details se completează conform figurii de mai jos.  

Dimensiunea elementelor va fi de 5mm. 

Behaviour va fi setată Hard.  

 

 

 

Așa va arăta distribuția meshului pe aceste linii (Edges) considerate.  
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Se va genera Mesh final. Acesta are ~490.000 elemente, valoare care se încadrează în limita de 

elemente pentru care licența pentru Ansys Student este valabilă (numărul maxim de elemente este 

512.000). 
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4.1.5 Configurarea cazului 

Se dă dublu click pe Setup, iar la mesajul următor se va răspunde cu Yes. Se dorește ca modificările 

anterioare să fie considerate în această etapă. 

 

Se va realiza la fel ca în cazul anterior cu grila de calcul formata din tetraedre. Atenție, dacă  s-a 

înlocuit doar meshul, toate setările anterioare s-au păstrat. Aceasta face ca singura operațiune 

necesară să fie cea de inițializare a soluției. 

Se va inițializa în același mod și anume inițializare de tip hibridă. 
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4.1.6 Calculul 

 

Calculul se va realiza tot pentru 500 de iterații. 

4.1.7 Postprocesarea  

Un exemplu de reprezentări grafice se poate vedea mai jos. 

4.1.7.1 Distribuția de temperatura  

Câmpul de temperatura printr-un plan median în domeniul de calcul se poate vedea mai jos. 
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Distribuția de temperatură pe fața rece și pe fața caldă a gemului termopan 

     

4.1.7.2 Câmpul de viteză 

 

Câmpul de viteza pentru componenta vy. 
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Se vor extrage profilele de temperatură și viteză utilizând o dreaptă creată utilizând aceleași 

coordonate ca în capitolul Reprezentarea grafică a unui profil de temperatură/viteză. 
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Exportați profilele de temperatură, “magnitude velocity” și pentru „Y Velocity” în Excel (utilizând 

metoda prezentată anterior în capitolul Reprezentarea grafică a unui profil de 

temperatură/viteză) și salvați fișierele cu denumirile:   

“profil de temperatură grila structurata.xlsx”. 

“profil de velocity magnitude grila structurata.xlsx”. 

Și 

“profil de Y velocity grila structurata.xlsx”. 

4.1.8 Compararea profilelor de temperatură din cazurile cu grila structurată și cea nestructurată 

În această etapă se vor compara cele 3 profile de temperatură/viteză salvate în capitolul 

Reprezentarea grafică a unui profil de temperatură/viteză cu cele 3 profile salvate în capitolul 

anterior. 

Pentru aceasta se vor deschide în prima fază cele doua fișiere “*.xlsx” care conțin profilele de 

temperatură salvate anterior în acest modul. 

Se da copy (copiază / ctrl + C) la graficul de temperatură din fișierul Excel (xlsx) care aparține grilei 

structurate, se trece în fișierul corespunzător grilei de calcul nestructurate, se selectează graficul de 

temperatură pentru grila nestructurată și se dă Paste (ctrl + V) peste acesta. 

Un exemplu cu comparația dintre profilele de temperatură în zona mediană pentru grila structurată 

și cea nestructurată poate să fie urmărită mai jos. 

 

În același mod, procedați și pentru profilele de viteza pentru “velocity magnitude” și pentru “Y 

velocity”.  

Ce observați când priviți aceste grafice? 

Ce concluzii puteți să dezvoltați? 
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4.1.9 Compararea câmpurilor de temperatura și viteză din cazurile cu grila structurată și 

nestructurată 

Pentru această operațiune se va crea un tabel cu 2 coloane, pe fiecare linie, regăsindu-se câte un tip 

de reprezentare grafică a mărimilor urmărite, pe prima coloană reprezentându-se câmpurile 

corespunzătoare grilei de calcul nestructurate, iar în coloana a doua cele corespunzătoare grilei de 

calcul structurate.  

Sub fiecare figură se va scrie ce reprezintă aceasta. 

Un exemplu este prezentat în tabelul de mai jos: 

  

Fig. 1a Distribuția de temperatură într-un 

plan median în cazul grilei de calcul 

nestructurate 

Fig.1a Distribuția de temperatură într-un plan 

median în cazul grilei de calcul structurate 

În același mod, continuați acest tabel imagini exemplificatoare cu mărimile analizate anterior pentru 

cele doua simulări numerice analizate. Sub fiecare set de figuri încercați să purtați o discuție cu 

privire la ce observați ca deosebiri între cele doua figuri sau ca fenomenologie, daca este cazul. 

Urmăriți cerințele de la începutul capitolului pentru completarea acestui modul. 

Pe lângă reprezentarea și compararea mărimilor din tabelul anterior, să se compare, pentru cele 

două meshuri create anterior, și: 

• Distribuția fluxului de căldură 

• Câmpul de vectori de flux de căldură 

• Valorile de minim și maxim pentru fluxul de căldură din domeniul de calcul 

• Valoarea medie a fluxului de căldură 

• Coeficientul global de schimb de căldură corectat 

• Profilele de temperatură și viteză extrase utilizând linia creată anterior prin mijlocul 

geamului (grafic din Excel) 

• Câmpul de magnitudine a vitezei (Velocity Magnitude) 
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• Câmpul de viteză corespunzător direcției de curgere a aerului din interiorul geamului 

termopan (Y Velocity)  

• Încercați și alte variante de reprezentare grafică a altor mărimi sau variante de reprezentare 

pentru a surprinde mai bine eventualele diferențe dintre grilele de calcul. 

La fiecare comparație să se poarte o discuție după modelul din tabelul anterior. 

Se observă că prin compararea profilelor de temperatură nu este foarte clar dacă sunt diferențe 

între cele două meshuri. În situația aceasta, se recomandă suprapunerea graficelor unul peste 

celălalt. 

Aceasta se realizează dând comanda Copy pe graficul care reprezintă profilul de temperatură pentru 

meshul cu un număr mai mare elemente, după care se dă comanda Paste (lipește) peste graficul 

corespunzător meshului cu un număr mai mic de elemente. 

În imaginea de mai jos aveți doua exemple. 

Încercați să obțineți același tip de grafice. 

4.2 Determinarea zonei unde va apărea fenomenul de condensare pe suprafața feței calde 

a geamului termopan 

Pentru această analiză se vor utiliza datele obținute din simularea numerică a cazului care a 

utilizat grila de tip structurat. 

Pentru exemplul prezentat mai jos, parametrii aerului interior sunt: 

• Temperatura aerului interior: 22℃; 

• Umiditatea relativă a aerului interior: 55%. 

Se cunoaște că fenomenul de condensare a vaporilor de apă conținuți de către aer se va realiza doar 

dacă acest aer trece peste o suprafață cu o temperatură mai scăzută decât temperatura punctului 

de rouă a acestuia. 

Umiditatea relativă a aerului umed se definește ca fiind raportul dintre cantitatea de vapori 

existentă în aer și cantitatea maximă de vapori de apă pe care o poate absorbi aerul la acea 

temperatură. O definiție mai exactă este: umiditatea relativă este raportul dintre presiunea parțială 

a vaporilor de apă din aerul umed și presiunea de saturație a aerului umed.  

Prin utilizarea programului Coolpack se poate genera o diagrama h-x a aerului umed, cu ajutorul 

căreia se poate determina cu ușurință prin metoda grafică, valoarea temperaturii punctului de rouă, 

de la care apare condensul vaporilor de apă pe suprafața considerată a geamului termopan.  

Primul pas este reprezentarea punctului I (parametrii aerului interior) pe diagrama h-x. Punctul R 

(punctul de rouă) se obține prin trasarea unei verticale (umiditate absolută constantă) către curba 

aerului saturat (RH 100%). La intersecția cu aceasta se obține punctul de rouă. 

Temperatura se poate citi în acest moment din partea stângă a diagramei h-x (izotermele sunt 

reprezentate cu culoare albastră). 
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O mărire a imaginii poate să fie văzută mai jos. Din diagramă se observă că temperatura punctului 

de rouă este de 12.5℃ în acest caz pentru parametrii dați ai aerului interior.  

 

Cunoscându-se valoarea temperaturii punctului de rouă se poate determina suprafață unde este 

foarte probabil să apară fenomenul de condensare al vaporilor de apă din aerul interior. 

Pentru aceasta se deschide cazul numeric al geamului termopan care a fost rulat cu grila de tip 

structurat și se reprezintă grafic distribuția de temperatură pe suprafața feței calde a geamului tip 

termopan. Se debifează Global Range. 
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Se observă că temperatura variază pe această suprafață, în acest caz, între 10.45 și 19.7℃. Se 

poate vedea mai jos această variație. 

 

Pentru a izola doar zona unde apare fenomenul de condensare a vaporilor de apă, se debifează Auto 

Range și se trece la valoarea Max, valoarea temperaturii punctului de rouă determinată anterior. 
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Zona afectată de acest fenomen este prezentată mai jos. 

 

Se observă că acest fenomen va afecta partea de jos geamului termopan, după cum era de 

așteptat. 

Mai jos se poate vedea un zoom în acea zonă. 
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Pentru determinarea cât mai precisă a înălțimii zonei afectate, se va trasa un profil de temperatură 

pe direcția înălțimii geamului termopan, în mijlocul feței calde a acestuia. 

Pentru aceasta se creează dreapta cu ajutorul căreia se vor extrage valorile de temperatură. Atenție 

la valorile individuale ale dimensiunii geometriei. 

 

În continuare se va genera profilul de temperatură prin mijlocul feței calde a geamului. 
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Se va exporta profilul în Excel bifând opțiunea Write to File, salvând fișierul și ulterior încărcându-l 

în Excel după cum s-a mai făcut în capitolul Reprezentarea grafică a unui profil de 

temperatură/viteză. 

 

Se observă că valoarea de 12.5℃ este situată la distanța de 25-30mm de partea de jos a geamului 

termopan. 

Prin interpolare liniară s-a determinat că fenomenul de condensare a vaporilor de apă din aerul 

interior, se va manifesta în primii 27.53mm. 

Profilul de temperatură pentru fața caldă a geamului termopan, pe înălțimea să se poate vedea mai 

jos. 

 

Generați acest profil și determinați înălțimea până la care apare condensul pe suprafața 

geamului termopan prin utilizarea datelor de intrare individuale. 
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5 Modulul 5 – Studiu prin simulare numerică.  

Simularea numerică a radiației termice și a convecției naturale  

Caz particular: Încălzirea de tip radiativ într-o încăpere  

 

 

 

 

 

 

 

 

 

 

Program utilizat: Ansys 

Pachet: Fluid Flow - Fluent  

Geometria: Design Modeler 

Mesh: Ansys Meshing 

Solver: Fluent 

Postprocesare rezultate: Fluent, Microsoft Office Word și Excel  
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5.1 Generalități 

În acest modul s-a lucrat cu versiunea de program Ansys 2020 rev2.  

În versiunile următoare ale programului Ansys este posibil ca anumite comenzi sau butoane să difere 

față de această versiune. 

Se consideră cazul simplificat al unei încăperi pe timp de iarnă. 

Dreptunghiul verde din imaginea de mai jos reprezintă panoul radiant in infraroșu și modul său de 

dispunere. 

   

Modul de amplasare și de funcționare al acestor panouri radiante pentru aplicații domestice poate 

să fie văzut în imaginile de mai jos.  
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5.2 Cerințe 

5.2.1 Obiective 

1. Simularea numerică a procesului de transfer de căldură prin radiație termică și prin 

convecție naturală 

2. Utilizarea modelului de radiație de tip suprafață - suprafață (S2S – (Surface to Surface) în 

ANSYS Fluent. 

3. Configurarea condițiilor la limită pentru o problemă de transfer de căldură care implică 

convecție naturală și radiație termică. 

4. Monitorizarea stabilității soluției numerice  

5. Reprezentarea vectorilor de viteză și a distribuției de temperatură pe perete, precum și a 

fluxului de căldură de tip radiativ și convectiv.  

5.2.2 Etapele studiului prin simulare numerică 

1. Să se identifice construcția geometrică. 

2. Să  se poarte o discuție în etapa de preanaliză cu scopul identificării strategiei de urmat în 

această simulare numerică.  

3. Să  se realizeze geometria în aplicația Ansys Student în pachetul Fluid Flow (Fluent) utilizând 

programul Design Modeler. 

4. Să  se realizeze grila de calcul (mesh). 

5. Să  se definească materialele care intra în componența schiței furnizate anterior. 

6. Să  se definească condițiile la limită. 

7. Să se impună condiții la limită de tip perete multistrat. 

8. Să  se ruleze cazul cu condițiile date. 

9. Să  se reprezinte grafic distribuția de temperatură. 

10. Să  se reprezinte grafic câmpul de viteză în zona mediană precum și câmpul vectorial de 

viteză 

11.  Să se reprezinte izosuprafețe de temperatură cu 4 temperaturi identificate de interes pentru 

acest caz. 

12. Să se reprezinte grafic, un profil de temperatura în centrul încăperii între podea și tavanul 

acesteia.  

13. Să se reprezinte grafic acest profil de temperatură în Excel.  

14. Să se realizeze un raport într-un editor de text (Microsoft Office Word) care să detalieze 

punctele 1-13. 

15. Suplimentar: Să se realizeze simularea numerică pentru situația în care sursa de căldură 

radiantă are temperatura de 110℃. 

16. Suplimentar: Să se compare rezultatele obținute în simularea numerică pentru cele două 

situații.  
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17. Suplimentar: Care este acum ponderea fluxului radiativ față de fluxul de căldură convectiv 

natural?  

18. Suplimentar: Să se realizeze un raport într-un editor de text (Microsoft Office Word), în 

continuarea celui anterior, care să detalieze comparația între cele două cazuri insistând pe 

diferențele dintre acestea. 

5.2.3 Parametrii de lucru 

Încăperea are dimensiunile de 4m x 3m x 2.5m și în acest exemplu are prevăzut un corp de încălzire 

de tip radiativ (vezi figurile de mai jos). În cadrul aplicațiilor individuale, fiecare utilizator va alege 

din larga diversitate de echipamente de încălzire radiativă destinate încălzirii clădirilor familiale. 

Dispunerea panoului radiant poate să fie pe unul din pereții interiori sau pe tavan. Exemplul din 

acest modul va avea amplasată unitatea de încălzire radiativă pe peretele opus peretelui exterior. 

Temperatura mediului exterior: -15℃ 

Coeficient de convecție mediu exterior : 23 W/m2K 

Temperatura sursă de căldură radiantă: 95℃ 

Componența pereților încăperii: este descrisă în tabelul de mai jos. Valorile sunt unele orientative, 

recomandarea fiind ca fiecare cursant să își personalizeze aceste valori. Mai multe detalii se pot 

găsi în capitolul dedicat condițiilor la limită. 

Denumire perete Material/condiție Grosime (mm) Tip perete 

Suprafață corp 

încălzire 

Nu este necesar 0  Corp încălzire 

Perete față Gips carton + vata 

minerală sticlă + gips 

carton 

15+100+15 Interior 

Perete spate BCA + Vată bazaltică 370+100 Exterior 

Perete stânga Gips carton + vata 

minerală sticlă + gips 

carton 

15+100+15 Interior 

Perete dreapta Gips carton + vata 

minerală sticlă + gips 

carton 

15+100+15 Interior 

Tavan Beton armat + Vată 

bazaltică 

200+150 Exterior 

Podea Beton armat 250 Interior 
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5.3 Preanaliza 

În această etapă se vor purta discuții referitoare la cea mai bună modalitate de abordare a acestei 

simulări numerice a transferului de căldură de tip radiativ si prin convecție naturală. 

Se va considera că temperatura suprafeței corpului de încălzire este una constantă. 

Datorită faptului că mișcarea aerului în încăpere este pur gravitațională, generată de diferențele de 

densitate între aerul mai cald și cel mai rece din încăpere, se poate face presupunerea că curgerea 

aerului în încăpere are loc la viteze mici în regim de curgere laminar. 

Datorită utilizării condițiilor la limită de tip Wall multistrat, numărul de elemente din grila de calcul 

se va mări în mod automat față de grila realizată în etapa de meshing, deoarece, vor apărea celule 

virtuale și în zonele care au fost create prin intermediul condițiilor la limită așa că numărul de 

elemente din grila de calcul va trebui sa fie în jur la 450.000 elemente și nu 512.000 elemente 

(limitare licență de tip student). 

5.4 Configurarea zonei de lucru 

Se deschide Ansys Workbench 

Se va deschide o fereastră asemănătoare cu cea de mai jos. 

 

Se dă dublu click pe Fluid Flow (Fluent) din panoul din stânga → Analysis Systems.  

În Project Schematic se va deschide fereastra Fluid Flow (Fluent). Se observă că aceasta va afișa 

etapele prin care se va trece în mod obligatoriu pentru realizarea acestei simulări numerice.  
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5.5 Geometria 

Geometria de interes trebuie să fie aproximată printr-un model geometric de tip CAD.  

De la bun început trebuie avut în vedere compromisul între claritatea detaliilor modelului CAD şi 

gradul de simplificare al acestuia.  

Cu cât geometria modelului reprezintă cu mai mare acuratețe geometria reală, cu atât mai mult 

rezultatele obținute vor fi mai precise.  

Totodată, geometria reală are de obicei foarte multe detalii care nu influenţează câmpul curgerii, 

sau o fac într-o măsură foarte mică, dar care păstrate pot să ducă la o mărire nejustificată a 

numărului de elemente din grila de discretizare geometrică, ceea ce va duce la creşterea timpului 

de calcul sau/şi a resurselor de calcul necesare. 

În această etapă vom specifica un aspect cheie al modelului nostru matematic, și anume domeniul 

de interes în care se vor rezolva ecuațiile de guvernare.  

Se va deschide Design Modeler: Click dreapta pe Geometry →New Design Modeler Geometry. 

Se observa ca in partea dreapta este selectata opțiunea 3D la Analysis Type. 
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Se selectează planul ZX. 

Se creează o schiță în acest plan, iar în această schiță se desenează un dreptunghi cu unul din colțuri 

în origine.  
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Se dimensionează dreptunghiul ca având dimensiunea de 3m x 4m. 

 

Cu comanda Extrude se creează o încăpere cu înălțimea de 2.5m. 
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Se da click pe Generate. 

 

Pentru crearea corpului radiativ, se va crea o schiță în planul YZ  și în această schiță se desenează un 

dreptunghi cu dimensiunile de 0.7m x 0.4m, în mijlocul peretelui de 3m creat anterior, cu baza la 

1m de podea (după exemplul de mai jos). 



154 
 

Se va alege comanda Extrude pentru schița nou creată. 

În meniul de Details la Operation se alege comanda Imprint Faces.  

Se va asigura că direcția extrudării este cea în care se găsește corpul. 

Valoarea adâncimii de extrudare nu este importantă deoarece fața care se va imprima cu conturul 

corpului de încălzire radiativă se găsește în același plan cu schița. 

 

Se dă click pe Generate.  

Suprafața nou creată va arăta ca mai jos. 
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În tree outline în 1part, 1 body se dă click pe Solid și i se schimbă denumirea în meniul de Details din 

Solid în Aer_Incapere. Tot aici, se selectează mediul ca fiind Fluid. 

 

5.6 Salvarea cazului 

Pentru evitarea pierderii datelor, recomandarea este să se efectueze o salvare cel puțin înainte de 

efectuarea oricărui tip de operațiuni. 

Workbench → File → Save As → Denumire aleasă 
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5.7 Denumirea suprafețelor 

Denumirea suprafețelor se poate realiza atât în Design Modeler cât și în Ansys Meshing. 

În continuare denumirea suprafețelor va fi realizată în Ansys Meshing. 

Se va deschide Mesh din Workbench. 

 

După cum s-a amintit și anterior, denumirea suprafețelor care mărginesc domeniul de interes este 

deosebit de importantă deoarece, aceste suprafețe vor deveni condiții la limită în problema 

investigată și o definire cât mai riguroasă a acestor condiții la limită presupune identificarea, 

gruparea și denumirea tuturor acestor suprafețe. 

Deoarece există posibilitatea ca din neatenție, utilizatorul să denumească accidental o suprafață de 

două ori, ceea ce duce la apariția unor erori ce nu face posibilă continuarea cazului până la 

identificarea acestei suprafețe, uneori o soluție e ca după denumirea fiecărei suprafețe, aceasta să 

se ascundă cu comanda “hide”, în felul acesta, în raza vizuală rămânând doar suprafețele care nu au 

fost denumite. 

Considerând peretele pe care se găsește corpul de încălzire, peretele din față (wall_fata), celelate 

suprafețe vor fi denumite conform figurilor următore. 
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5.8 Realizarea grilei de calcul (mesh) 

Scopul acestui exemplu este studiul fenomenului de convecție si radiație într-o încăpere. Tipurile de 

grile de calcul și verificarea rezultatelor au fost realizate în modulele anterioare. În acest exemplu 

nu se va efectul studiul de independență a soluției față de numărul de elemente din grila de calcul 

modalitatea de realizare fiind studiată în capitolele anterioare. 

Se va configura stratul limită cu ajutorul comenzii “Inflation”. Click dreapta în Tree Outline pe 

Mesh→Insert→Inflation. 

 

În fereastra Details se vor configura proprietățile stratului limită.  

Se va selecta pentru Geometry, întregul domeniu de calcul, pentru boundary, se vor selecta toate 

suprafețele din cadrul domeniul de calcul. Se reține opțiunea Smooth transition care are configurate 

10 straturi de celule pentru stratul limită din apropierea pereților. Rata de creștere implicită și care 

va fi folosită și în acest exemplu educativ este 1.2. 

 

Dimensiunea celulei din grila de calcul a fost setată la valoarea de 7cm. 
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Meshul nestructurat rezultat va avea 435886 elemente. 

 

O evaluare a calității grilei de calcul se poate realiza cu ajutorul comenzii Quality. Se observă că grila 

de calcul realizată este compusă din două tipuri de elemente și anume prisme (wedges) în stratul 

limită și tetraedre în restul domeniului de calcul.  

În figura de mai jos, ca indicator de calitate a fost utilizat nivelul de Skewness (asimetrie a 

elementelor). Se observă că nivelul de Skewness este unul acceptabil. 

 

O secțiune în plan median în grila de calcul este prezentată mai jos. 
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5.9 Configurarea cazului 

5.9.1 Calculul paralel  

Din fereastra Workbench se deschide Setup. 

 

Se poate mări numărul de Solver Processes în funcție de numărul de nuclee de calcul disponibile pe 

calculatorul unde se va efectua simularea numerică. Aceasta va duce la scurtarea timpului de calcul 

pentru simularea numerică.  
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5.9.2 Activarea forței gravitaționale 

Modelul geometric este afișat în imaginea următoare. 
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În imaginea de mai sus se poate vedea modul în care a fost împărțită geometria de către solver, ca 

urmare a alegerii modului de calculare a soluției pe 4 nuclee ale procesorului. 

Se setează ca forța gravitațională să acționeze conform realității cazului studiat. În cazul de față se 

observă că forța gravitațională trebuie să acționeze pe direcția -Y. 

 

Restul opțiunilor legate de solver rămân neschimbate.  

În această etapă se poate configura ca simularea numerică să fie realizată în regim nestaționar sau 

se determină dacă modelarea numerică se poate simplifica astfel încât să fie abordată din punct de 

vedere al unui regim staționar.  

Regimul staționar se definește ca starea în care toate variabilele de stare din domeniul de interes 

(presiune, temperatura, viteza, etc.) rămân constante în pofida faptului că există procese în 

desfășurare în acel domeniul de interes. De exemplu, în cazul de față unde există atât curgere cât și 

transfer de căldură, se poate face presupunerea că valorile de temperatură, presiune, viteză, 

precum și alte variabile din curgere rămân constante în timp pentru orice punct din domeniul de 

calcul investigat. 

Spre deosebire de regimul staționar, regimul nestaționar presupune o variație în timp a variabilelor 

de stare în domeniul de interes. 

În cazul de față se va selecta regimul staționar (Time -- Steady). 
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5.9.3 Schimbarea unităților de măsură 

 Tot în panoul General se pot schimba în această etapă unitățile de măsura pentru diverse mărimi. 

De exemplu se poate schimba ca temperatura să apară în interfața grafică în ℃ în loc de K. 

 

5.9.4 Modelele numerice  

5.9.4.1 Ecuația energiei 

În panoul dedicat Modelelor se va bifa modelul Energy, activând-se în acest mod ecuația conservării 

energiei. 
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5.9.4.2 Modelul pentru curgerea vâscoasă 

Datorită faptului că mișcarea aerului în încăpere este pur gravitațională, generată de diferențele de 

densitate între aerul mai cald și cel mai rece din încăpere, se poate face presupunerea că curgerea 

aerului în încăpere are loc la viteze mici în regim de curgere laminar. 

 

5.9.4.3 Modelul pentru radiația termică 

Corpul de încălzire va încălzi încăperea atât radiativ cât și convectiv. Se cunoaște că procesul de 

convecție este un proces de transmitere a căldurii între un fluid și un corp solid. 

Componenta convectivă va fi simulată numeric cu ajutorul celor două modele configurate anterior 

(modelul energiei și cel pentru curgerea vâscoasă).  

Modelul radiativ care va fi configurat este modelul Surface to Surface (S2S) deoarece transferul de 

căldură de tip radiativ se va realiza între suprafețele care delimitează domeniul de calcul, aflate la 

temperaturi diferite. 
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După cum știm, schimbul de energie între două suprafețe depinde în parte de dimensiunea, distanța 

dintre ele precum și de orientarea lor relativă, una față de alta. Acești parametri statici pot să fie 

contabilizați cu ajutorul unei funcție geometrice numită „factor de vizualizare” (view factors). 

Modelul de radiație de tip Suprafață către Suprafață (S2S) poate fi utilizat pentru a calcula schimbul 

de căldură prin radiația termică într-o incintă în care suprafețele sunt gri (din punct de vedere termic 

radiativ). 

Când radiația electromagnetică (radiația termică) cade pe o suprafață a unui obiect, radiația este 

parțial absorbită, parțial reflectată și parțial transmisă. Dacă toată radiația electromagnetică este 

absorbită de obiect, obiectul este numit corp negru. 

O suprafață gri, sau un corpul gri, din punct de vedere termic radiativ reprezintă o suprafață/corp 

care reflectă / absoarbe o fracțiune dată din radiația termică pe care ar putea să o absoarbă o 

suprafață a unui corpu negru. Mai important, fracția de radiație termică reflectată sau absorbită de 

către corpul gri / corpul negru este independentă de lungimea de undă a radiației. 

Modelul radiativ S2S presupune că toate suprafețele sunt gri și difuze. Astfel, conform modelului 

corpului gri, dacă o anumită cantitate de radiație este incidentă pe o suprafață, atunci o fracție din 

aceasta este reflectată, o fracție este absorbită și o fracție este transmisă. Principala presupunere a 

modelului S2S este că orice absorbție, emisie sau împrăștiere a radiației de către mediu poate fi 

ignorată. Prin urmare, numai radiația „suprafață la suprafață” este luată în considerare pentru 

analiză. 

Trebuie remarcat faptul că pentru majoritatea aplicațiilor, suprafețele în cauză sunt opace față de 

radiația termică (în spectrul infraroșu), astfel încât suprafețele pot fi considerate opace. Pentru 
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suprafețele gri, difuze și opace, este valabil să se presupună că emisivitatea este egală cu 

absorbtivitatea și că reflectivitatea este egală cu 1 minus emisivitatea. 

Factorii de vizualizare (view factors) pot să fie calculați înainte de simularea propriuzisă deoarece 

aceștia depind doar de geometria domeniului de interes.  

Pentru aceasta se alege opțiunea Compute/Write/Read și se salvează fișierul cu view factors în 

directorul de lucru. 

 

5.9.5 Configurarea materialelor 

5.9.5.1 Fluidul de lucru 

Fluidul de lucru pentru situația aceasta va fi aerul ambiant.  

Se va schimba modul în care este utilizată densitatea din punct de vedre numeric. Astfel, se va 

schimba modul de adresare a densității de la o valoare constantă în una variabilă în funcție de 

ecuația de stare a gazului ideal. Dacă nu se face această modificare, densitatea aerului nu va varia 

în funcție de temperatura sa, deci nu va avea loc mișcarea gravitațională așteptată (convecția 

naturală). 

În această etapă are loc definirea fluidului şi materialului solid (dacă este cazul). În funcţie de tipului 

fluidului, din biblioteca Fluent-ului se poate alege dintr-o mare diversitate de materiale sau se poate 

configura un material nou, putându-se schimba proprietăţile care caracterizează fluidul, precum şi 

legea după care acestea variază. 

De exemplu, în cazul în care există variaţii mici de presiune în curgere, dar variaţiile de temperatură 

sunt mari, este recomandată utilizarea legii gazului ideal incompresibil pentru variaţia densităţii. 
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Această opţiune calculează densitatea în funcţie doar de temperatură. Utilizată în cazurile potrivite, 

această opţiune influenţează pozitiv convergenţa soluţiei, fără a sacrifica din precizia de calcul. 

 

5.9.5.2 Materialele solide 

Se observă că materialul implicit este aluminiul. Se vor modifica proprietățile acestuia să fie cât mai 

aproape de cele ale unui perete exterior. Astfel, se va alege o vata bazaltica pentru caracterizarea 

termică a acelor perete. Se vor modifica câmpurile colorate din imaginea de mai jos.  
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Din Fluent Database se poate alege unul din materialele existente pentru pereții interiori. Astfel se 

va alege ghips din biblioteca Fluent pentru acești pereți. 

 

Vata minerală de sticlă pentru izolația destinată peretelui din gips carton. 
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Beton Celular Autoclavizat (BCA) 

 

 

Beton armat din structura planșeului 
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Astfel, materialele utilizate în această analiză vor fi următoarele. 

 

5.9.6  Condițiile de operare (operating conditions) 

În momentul în care a fost configurată densitatea fluidului de lucru ca fiind variabilă, a apărut un 

mesaj de avertizare în consolă care a transmis că densitatea de operare trebuie să fie setată la 

valoarea 0 kg/m3 pentru această situație, densitatea urmând să fie calculată în funcție de 

temperatura si presiunea aerului. 

 

Pentru aceasta, se deschide meniul Operating Conditions din Cell Zone Conditions și se setează 

valoarea densității de operare la 0 kg/m3. 
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5.9.7 Condițiile la limită (Boundary Conditions) 

Ecuațiile care guvernează curgerea fluidelor, se aplică în cazul curgerii subsonice sau supersonice, 

compresibile sau incompresibile, vâscoase sau ideale.  

Caracteristicile curgerii în toate aceste cazuri sunt diferite, chiar dacă ecuaţiile care le guvernează 

sunt aceleași.  

Prin impunerea condiţiilor la limită, a condiţiilor inițiale, a proprietăţilor de material, precum şi a 

modului în care se calculează aceste proprietăți (viscozitatea, căldura specifică, densitatea, 

conductivitatea termică), se poate face diferențierea între aceste cazuri.  

Condiţiile la limită, şi uneori condiţiile inițiale, dictează soluția particulară care se va obține prin 

integrarea ecuaţiilor diferențiale. Ecuaţiile care tratează curgerea fiind cunoscute, totuşi condiţiile 

la limită sunt cele care particularizează soluția de la caz la caz. Aceasta are o importanţă deosebită 

în simularea numerică de tip CFD, astfel încât orice soluţie numerică a ecuaţiilor care guvernează 

curgerea trebuie obținută printr-o reprezentare numerică riguroasă a condiţiilor la limită, adecvate 

cazului studiat. 

Mai mult decât atât, condițiile la limită (boundary conditions) sunt elemente extrem de importante 

în simularea numerică deoarece este principala modalitate prin care utilizatorul poate să 

configureze simularea numerică pentru a se apropia cât mai mult de parametrii doriți în simularea 

numerică. 

Condițiile la limită descriu parametrii/mărimile pe frontiera domeniului de interes, această 

informație de pe frontieră propagandu-se în domeniul de calcul prin intermediul modelului 

matematic utilizat.  

Evident, că dacă condițiile la limită nu vor fi suficient de bine configurate/alese și rezultatele 

obținute vor avea de suferit. În limba engleză expresia consacrată în domeniul CFD pentru acest 

lucru este “Garbage IN, Garbage OUT!”. Adică, dacă se vor introduce date de intrare/condiții la limită 

necconforme și rezultatele obținute vor fi greșite/neconforme/departe de realitate. În această 

situație, principalul răspunzător va fi utilizatorul și nu modelul matematic. 

În exemplul analizat în acest modul, toate condițiile la limită sunt de tip pereți, neexistând condiții 

la limită care să permită schimbul de masă.  

Pentru situația particulară din exemplu studiat se vor aloca următoarele caracteristici condițiilor la 

limită. Se observă că există o simplificare a structurii și numărului straturilor de materiale.  

Tabelul de mai jos este prezentat și în partea introductivă. 
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Denumire perete Material/condiție Grosime (mm) Tip perete 

Suprafață corp 

încălzire 

Nu este necesar 0  Corp încălzire 

Perete față Gips carton + vata 

minerală sticlă + gips 

carton 

15+100+15 Interior 

Perete spate BCA + Vată bazaltică 370+100 Exterior 

Perete stânga Gips carton + vata 

minerală sticlă + gips 

carton 

15+100+15 Interior 

Perete dreapta Gips carton + vata 

minerală sticlă + gips 

carton 

15+100+15 Interior 

Tavan Beton armat + Vată 

bazaltică 

200+150 Exterior 

Podea Beton armat 250 Interior 

 

5.9.7.1 Pereții interiori 

Pentru situația pereților interiori, condiția la limită se va configura în panoul de Thermal ca fiind de 

tip mixat (convecție + radiație). Se setează pentru început proprietățile transferului de căldură prin 

peretele din dreapta utilizând valorile din exemplul de mai jos.  

Din units se va schimba unitatea de măsură din m în mm pentru o introducere mai ușoară a 

straturilor de perete. Peretele acesta este compus din 3 straturi (Gips carton + vata minerală sticlă 

+ gips carton) cu grosimea din tabelul de mai sus. Cei 15mm ai stratului de gips carton cuprind și 

straturile de la suprafața sa. 
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Bifând Shell Conduction se intră în meniul care permite definirea straturilor care compun pereții 

interiori. 

 

Pentru ceilalți pereți interiori, nu este nevoie să se mai introducă o dată toate aceste valori. Este 

suficient să se copieze aceste condiții la limită. 

Din meniul de Boundary Conditions se alege comanda Copy. 

 

Se selectează condiția configurată anterior, în partea stângă, conform figurii următoare, iar în partea 

dreapta se aleg acele zone care sunt identice ca setări. 

Se apasă copy și se poate verifica dacă aceste condiții la limită s-au actualizat conform specificațiilor.  
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5.9.7.2 Peretele exterior 

Peretele exterior este cel cu denumirea wall_spate în această situație.  

 

Acesta are 2 straturi. 
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5.9.7.3 Tavanul 

Tavanul este compus tot din 2 straturi în această situație. Se consideră că încăperea analizată are 

plafonul în contact direct cu exteriorul (ultimul etaj). 

 

Ca material izolator, în situația aceasta se va lucra tot cu proprietățile termice ale vatei bazaltice. 
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5.9.7.4 Podeaua 

În cazul podelei se va impune un singur material și anume betonul armat deoarece se consideră o 

podea compusă din beton armat + sapa + adeziv gresie + gresie. Pentru o rigurozitate crescută 

utilizatorii sunt încurajați să lucreze cu mai multe straturi de material. 

 

 

5.9.7.5 Peretele corpului de încălzire 

În cazul corpului de încălzire condiția la limită pentru suprafețele aflate în contact cu aerul din 

încăpere se poate realiza prin mai multe moduri.  
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Dat fiind faptul că simularea numerică este realizată în regim staționar iar regimul de funcționare al 

unui corp de încălzire este unul nestaționar sau la o putere mai mică decât puterea sa nominală, se 

consideră o valoare medie a temperaturii suprafeței copului radiativ de 95℃. 

 

5.9.7.6 Impactul utilizării condițiilor la limită de tip wall multistrat asupra grilei de calcul. 

Cu toate că grila de calcul nestructurat rezultată a avut 435886 elemente datorită utilizării condițiilor 

la limită de tip Wall multistrat, numărul de elemente din grila de calcul s-a mărit în mod automat, 

deoarece, au apărut celule virtuale și în zonele care au fost create prin intermediul condițiilor la 

limită. 

 

După aceste configurări meshul s-a mărit la 477218 elemente, deci a crescut cu 41332 elemente 

adică cu 9.5%. 

5.10 Configurarea parametrilor numerici ai soluției 

Este important ca și cuplarea dintre viteză-presiune să fie realizată prin utilizarea schemei 

Coupled.  

Discretizarea spațială pentru presiune va fi de tip Body Force Weighted. 

Se va asigura ca opțiunea Pseudo Transient este selectată 
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5.11 Configurarea reziduurilor pentru variabilele calculate 

Outline View → Solution  → Monitors → Residual  

Valoarea impusă de utilizator a criteriului absolut pentru reziduurile variabilelor calculate se poate 

vedea în imaginea de mai jos. 
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5.12 Configurarea unor puncte de monitorizare a valorilor calculate 

5.12.1 Identificarea zonelor monitorizate 

În vederea verificării stabilității soluției se recomandă monitorizarea unor mărimi în puncte situate 

în zone critice ale domeniului investigat. Mărimile monitorizate pot să fie de exemplu temperatura, 

viteza, presiunea, densitatea, etc.. Zonele critice pot să fie zone în care se așteaptă să apară 

variații/gradienți mari ai mărimilor monitorizate. 

În situația analizată în exemplul curent, punctele de monitorizare vor fi asociate zonelor de interes 

care se găsesc în următoarele regiuni ale domeniului investigat. 

Punctul 1 – deasupra corpului de încălzire la 25 de cm de tavan. 

Punctul 2 – în centrul încăperii 

Punctul 3 – in mijlocul podelei la 1 cm de aceasta 

Punctul 4 – în mijlocul tavanului la 1 cm de acesta 

Punctul 5 – în centrul peretelui exterior la 1 cm de aceasta și la 1.2m de podea. 

Mărimea monitorizată va fi temperatura în toate aceste puncte. 

5.12.2 Crearea punctelor pentru monitorizare 

În prima fază se va reprezenta grafic geometria investigată în așa fel încât să se vadă și în interiorul 

său. 

 

Pentru crearea punctelor se va utiliza unealta Create Point care se regăsește în Domain → Surface 

→ Create → Point. 
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Punctul 1 va fi creat deasupra corpului de încălzire la 25 de cm de tavan. Coordonatele acestui punct, 

în mm, corespunzătoare axelor X, Y, Z sunt 250, 2250, 1500. 

 

Punctul 2  va fi creat în centrul încăperii. Coordonatele acestui punct, în mm, corespunzătoare axelor 

X, Y, Z sunt 2000, 1250, 1500. 
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Punctul 3 – in mijlocul podelei la 1 cm de aceasta. Coordonatele acestui punct, în mm, 

corespunzătoare axelor X, Y, Z sunt 2000, 10, 1500. 

 

Punctul 4 – în mijlocul tavanului la 1 cm de acesta. Coordonatele acestui punct, în mm, 

corespunzătoare axelor X, Y, Z sunt 2000, 2490, 1500. 
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Punctul 5 – în centrul peretelui exterior la 1 cm de aceasta și la 1.2m de podea. Coordonatele acestui 

punct, corespunzătoare axelor X, Y, Z sunt 3990, 1200, 1500. 

 

Punctele astfel create pot să fie vizualizate utilizând comanda Display. 
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5.12.3 Configurarea punctelor de monitorizare 

Pentru primul punct de monitorizare (temperatura-punct-1-deasupra-corp-incalzire) se va proceda 

conform figurii de mai jos. 

Outline view → Solution → Report Definitions → New → Surface Report → Vertex Average → se 

ajunge în ultima fereastră unde se completează conform figurii de mai jos. 
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Pentru celelalte 4 puncte se va relua procedura mai sus, iar denumirea punctelor de monitorizare 

a temperaturii va fi 

Punctul 2 - temperatura-punct-2-centru-incapere 

Punctul 3 - temperatura-punct-3-centru-podea 

Punctul 4 - temperatura-punct-4-centru-tavan 

Punctul 5 - temperatura-punct-5-perete-exterior 

5.13 Inițializarea soluției 

Înainte de a începe simularea numerică de tip CFD, celulele din grila de calcul trebuie iniţializate prin 

atribuirea unei valori iniţiale de la care să înceapă calculul de tip iterativ.  

În multe cazuri, trebuie să se aiba grijă în plus pentru o inițializare corectă care să permită atingerea 

soluției finale. De exemplu, impunerea unei temperaturi inițiale ridicate care să permită inițierea 

automată a reacției chimice de ardere în momentul în care se începe calculul de tip iterativ. 

Se va alege o inițializare de tip hibrid. 
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5.14 Calculul soluției 

Se va configura calculul pentru regim staționar. Se va încerca un calcul cu 10000 de iterații. De obicei 

acesta este un număr prea mare de iterații dar datorită specificității cazului tratat este nevoie de 

această valoare. 

 

5.15 Convergența și stabilitatea soluției 

Se consideră că soluția a fost calculată în momentul în care criteriul de convergența impus anterior 

va fi atins. Aceasta se întâmplă, în general, în momentul în care variabilele soluţiei aproximative nu 
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mai variază semnificativ între două iterații iar reziduurile ecuațiilor scad sub valoarea prescrisă de 

utilizator înainte de începerea calculelor. 

Reziduurile se calculează pentru fiecare ecuație din modelul matematic. Reziduul pentru fiecare 

ecuație din modelul matematic depinde de suma reziduurilor pentru fiecare celulă din domeniul de 

calcul. 

În cazul analizat, convergența impusă pentru soluția calculată nu a fost atinsă datorită faptului că 

acest caz simulează numeric și un fenomen de convecție naturală care este instabil prin însăși natura 

sa. Acesta face ca instabilitățile inerente să se regăsească în lipsa convergenței.  

Se poate observa mai jos o figură cu ultimele 5500 de iterații din simularea numerică. Se observă ca 

reziduurile asociate cu cele  trei componente ale vitezei au rămas în jurul valorii de 4.5e-03. 

 

 

Cu toate ca reziduurile nu au avut convergența așteptată, se poate verifica stabilitatea soluției. 

Pentru aceasta s-au monitorizat o serie de 5 puncte aflate în zone de interes în domeniul investigat.  

Mai jos se poate vedea evoluția temperaturii in punctul 1 care se află situat deasupra corpului de 

încălzire la 25 de cm sub tavan, de-a lungul celor 10000 de iterații. Se observă că de la 8000 de 

iterații, valoarea temperaturii în acest punct nu a mai variat.  
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Pentru celelalte puncte se poate evalua variația mai jos. 

Punctul 2 – în centrul încăperii. Se observă aceiași tendință și în această situație. 

 

Punctul 3 – in mijlocul podelei la 1 cm de aceasta 
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Punctul 4 – în mijlocul tavanului la 1 cm de acesta 

 

Punctul 5 – în centrul peretelui exterior la 1 cm de aceasta și la 1.2m de podea. 
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Se observă că în toate punctele monitorizate soluția este stabilă. 

În această situație, soluția poate să fie stabilă dar din cauza unor erori (discretizare, liniarizare, tipul 

de precizie utilizată la calcule, etc) reziduurile nu scad sub valoarea presetata.  

De exemplu pentru calcule de tip „simplă precizie” (single precision), reziduurile pot scădea până la 

șase ordine de mărime până ca eroarea de rotunjire (round-off error) să își facă simțită prezența. 

Reziduurile calculate în “dublă precizie” pot scădea însă până la doisprezece ordine de mărime. 

Se poate vedea dacă soluția este una stabilă monitorizându-se o serie de variabile (temperatura în 

această situație) în anumite puncte critice situate în zone cu gradienți ridicați ai acestor variabile. 

Când valoarea soluției nu mai variază, aceasta poate să fie un indicator al faptului că soluția este 

stabilă iar simularea numerică se poate opri. 

O altă situație este dată de particularitatea cazului studiat. De exemplu, în cazurile de curgere cu 

constrângeri slabe, cum ar fi cazul convecției naturale, curgerea este, prin natura sa, cu șanse mari 

de a fi instabilă.  

5.16 Evaluarea rezultatelor 

În această etapă va avea loc analizarea rezultatelor. Există o mulţime de metode care vor facilita 

interpretarea rezultatelor.  

Acestea pot fi împărțite în metode grafice şi metode numerice de raportare. 

Metodele grafice de reprezentare disponibile sunt: 

• reprezentarea contururilor/hărților pentru variabilele calculate (presiune, temperatură, 
viteză); 

• reprezentarea vectorilor pentru variabilele calculate; 

• linii de curent şi traiectorii pentru particulele din curgere; 

• grafice cu variația în timp sau în spaţiu a mărimilor calculate; 

• animații. 
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Metodele numerice de raportare pot să fie: 

• bilanțuri pentru debite, fluxuri energetice; 

• integrarea pe suprafață sau volum a mărimilor calculate; 

• medierea mărimilor calculate pe suprafață sau volum; 

• valoarea forțelor sau a impulsului în anumite zone. 

5.16.1 Câmpul de temperatură 

Să se genereze un câmp de temperatură prin planul median al camerei. 

Crearea planului median vertical în încăpere.  

Domain → Surface → Create Plane 

 

După crearea planului, acesta va fi utilizat pentru generarea câmpului de temperatură  
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Se observă stratificarea temperaturii în încăpere precum și curentul convectiv generat de corpul 

radiant. 

Se pot încerca și alte reprezentări pentru alte câmpuri de temperatură. 

5.16.2 Câmpul de viteză 

Să se genereze un câmp de viteză prin planul median vertical al încăperii. 
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Se poate observa curentul de aer convectiv ascendent care își continuă deplasarea de-a lungul 

tavanului. 

5.16.3 Câmpul vectorial de viteză 

Să se genereze un câmp vectorial de viteză prin planul median vertical al încăperii. 

Un exemplu poate să fie văzut mai jos. 
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Se observă apariția unui curent de aer în sens orar datorat de influențele cumulate ale peretelui 

exterior (din dreapta) și de corpul de încălzire (stânga).  

În imaginile de mai jos se poate urmări câmpul vectorial de viteză în colțul din stânga sus și la cel din 

dreapta jos. 

    

5.16.4 Izosuprafețe 

Domain – Surface – Create -- Isosurface 
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Se vor extrage 4 izosuprafețe de temperatură relevante pentru cazul studiat. În această situație, au 

fost alese temperaturile de 22, 23, 25 si 30℃. 

Se observă că izosuprafața de 30 ℃ este prezentă doar în apropierea corpului de încălzire, acesta 
fiind responsabil de apariția acesteia. 

 

O izosuprafață de 25 ℃ poate să fie vizionată mai jos. Se observă că doar în partea sus și partea de 
deasupra corpului de încălzire are această zonă de temperatură mai mare de 25 ℃ dar care are o 
grosime scăzută. 
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O izosuprafață de 23 ℃ poate să fie vizionată mai jos. Se observă că zonele unde aerul are o 
temperatură mai mare de 23 ℃ s-au extins înspre interiorul încăperii.  

 

Mai jos se poate vedea o izosuprafață de 22 ℃ (verde). Se observă că majoritatea volumului 
aerului din încăpere are o temperatură mai mare de 22 ℃. 



195 
 

 

Toate cele 4 izosuprafețe pot să fie afișate în același timp. 
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5.16.5 Reprezentarea fluxului de căldură 

5.16.5.1 Fluxul de căldură radiat de sursa de căldură 

Contours – Wall fluxes – Radiation heat flux 

 

Se observă fluxul de căldură radiat de sursa de încălzire și de către peretele de deasupra sa care a 

fost încălzit de curentul convectiv ascendent. 

  

5.16.5.2 Fluxul de căldură de pe pereți 

Contours – Wall Fluxes – Surface Incident Radiation 
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Se observă că toată încăperea este încălzită de la sursa radiativă de căldură. 

 

5.16.6 Evaluarea fluxurilor de căldură 

5.16.6.1 Fluxul de căldură total 

Fluxul de căldură total pe suprafețe poate să fie calculat după cum urmează 

Results – Reports -- Fluxes – Total heat transfer rate 
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5.16.6.2 Fluxul de căldură radiativ 

Fluxul de căldură radiat pe suprafețe poate să fie calculat după cum urmează 

Results – Reports --  Fluxes – Radiation heat transfer rate 

 

5.16.6.3 Ponderea fluxurilor de căldură  

Se observă că valoarea fluxului de căldură total emis de către corpul de încălzire este de 270W din 

care 170W sunt componenta radiativă.  

Rezultă că în situația aceasta fluxul de căldură radiativ, reprezintă 63% din valoarea fluxului de 

căldură total. 

 

5.16.7 Temperatura medie a aerului din încăpere 

Temperatura medie a aerului din încăpere poate să fie calculată după cum urmează 

Results – Reports – Volume integrals – Volume average 
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Temperatura medie a aerului din încăpere are în această situație valoarea de 22.6℃. 

5.16.8 Temperatura medie a pereților din încăpere 

Temperatura medie pereților din încăpere poate să fie calculată după cum urmează 

Results – Reports – Surface integrals – Area Weighted Average 

 

Se poate observa mai sus valoarea medie a temperaturii fiecărei suprafețe denumite din 

geometria de interes. 

5.16.9 Reprezentarea unui profil de temperatură 

5.16.9.1 Crearea dreptei pentru extragerea profilului 

Profilul de temperatură va fi extras din centrul încăperii de la podea la tavan. 

Domain → Surface → Create → Line/Rake 
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Previzualizarea liniei se poate efectua prin activarea căsuței Line. 

 

5.16.9.2 Extragerea profilului de temperatură 

Results → Plot → XYPlot 

Se observă că profilul de temperatură este în direcția axei Y deci aceasta va fi axa aleasă în panoul 

de comandă pentru crearea profilului de temperatură. 
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Profilul de temperatură astfel obținut va arăta ca mai jos. 

 

Pentru o vizualizare mai rapidă și mai prietenoasă a profilului se pot realiza următoarele setări. 

Din panoul Solution XY Plot se alege Curves pentru afișarea profilului cu o linie continuă.  
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Din panoul Solution XY Plot se alege Axes pentru schimbarea modului de afișare a valorilor din 

grafic.  

   

Profilul de temperatură astfel configurat va arăta ca mai jos. 

 

5.16.9.3 Reprezentarea în Excel a profilului de temperatură 

Din panoul de comandă pentru reprezentarea profilului de temperatură se alege comanda Write. 



203 
 

 

Butonul Write va deveni activ. Va fi utilizat pentru salvarea fișierului cu date. 

Se va salva fișierul în locația potrivită. 

Următorul pas va fi deschiderea unei sesiuni în programul Microsoft Excel sau un alt program 

echivalent. 

File → Open → Browse (în locația unde a fost salvat anterior fișierul cu date) → All Files (deoarece 

nu este un fișier nativ Excel, acesta nu va fi vizibil fără această setare) → Open → Yes (Do you want 

to open it anyway?) 
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Datele importate in Excel vor fi afișate sub forma următoare. 

 

Coloanele se pot redenumi pentru o recunoaștere mai facilă. De asemenea se vor transforma 

unitățile de măsură în unele mai convenabile. 

Se sortează coloana cu lungimi în ordine crescătoare. 
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Un exemplu de reprezentare a unui profil de temperatură poate să fie văzut mai jos. 
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